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1 What�s New in This Release
What�s New in Siebel Correspondence, Proposals, and Presentations 
Guide, Version 7.8
Table 1 lists changes described in this version of the documentation to support release 7.8 of the 
software.

Table 1. New Product Features in Siebel Correspondence, Proposals, and Presentations Guide, 
Version 7.8

Topic Description

Siebel Correspondence, Proposals, 
and Presentations Guide

This book was created from a group of chapters in the 
Applications Administration Guide (version 7.7). There are no 
major new features for this release. 

�Scenario for Correspondence� on 
page 21

�Generating Correspondence (End 
User)� on page 27

Added information about saving changes made to external 
documents back to the Siebel file system. 
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2 Document Server
This chapter is about setting up the Document Server. It includes the following topics:

■ �About the Document Server� on page 9

■ �About Obtaining the Required Hardware for the Document Server� on page 9

■ �Process of Setting Up the Document Server� on page 10

■ �Installing the Siebel Server for the Document Server� on page 10

■ �Installing Microsoft Office Applications on the Document Server� on page 12

■ �Enabling the Component Group for the Document Server� on page 12

■ �Setting MaxTasks Parameters for the Document Server� on page 13

■ �About Synchronizing Components for the Document Server� on page 13

■ �(Optional) Configuration for the Document Server� on page 14

About the Document Server
The Document Server is required for Siebel Correspondence, Siebel Presentations, and Siebel 
Proposals. The Document Server is used to generate Microsoft Word and Microsoft PowerPoint 
documents.

About Running Document Server Functionality on Siebel Mobile Web 
Clients
This chapter focuses on installing and setting up the communal Document Servers that are used by 
(connected) Siebel Web Clients. However, the Siebel Document Server functionality is available for 
the Siebel Mobile Web Client as well. For example, this allows field sales representatives to generate 
proposals, presentations, and correspondences while traveling.

In the case of the Siebel Mobile Web Client, it is necessary that Microsoft Office be installed locally 
on the mobile machine to act as the Document Server. 

About Obtaining the Required Hardware 
for the Document Server
The Document Server is supported on Windows platforms only. This is because Microsoft Office only 
runs on the Windows platform. See the System Requirements and Supported Platforms on Siebel 
SupportWeb for information about which Windows platforms are supported.
Siebel Correspondence, Proposals, and Presentations Guide Version 7.8 9



Document Server ■  Process of Setting Up the Document Server
To maintain stability and performance, the Document Server must run on a dedicated host machine. 
The Siebel Server on this machine should host one instance of the Siebel Documents component 
group. No other components should be running other than required system components. 

The Document Server can be run successfully on a machine that meets the minimum hardware 
requirements for a Siebel installation. For example, a two-processor machine can be used.

To support more users, you can run additional instances of the Siebel Documents component group 
on additional dedicated host machines.

Process of Setting Up the Document 
Server
To set up the Document Server in preparation for using Correspondence, Presentations, or Proposals, 
perform the following tasks: 

■ �Installing the Siebel Server for the Document Server� on page 10

■ �Installing Microsoft Office Applications on the Document Server� on page 12

■ �Enabling the Component Group for the Document Server� on page 12

■ �Setting MaxTasks Parameters for the Document Server� on page 13

Installing the Siebel Server for the Document Server
This task is a step in �Process of Setting Up the Document Server� on page 10.

Install the Siebel Server on the dedicated host machine of the Document Server. For general 
information about installing the Siebel Server, see Siebel Installation Guide for Microsoft Windows: 
Servers, Mobile Web Clients, Tools.

During installation, you have the option to enable component groups. Select the Siebel Documents 
and the System Management component groups. Do not enable any other component groups. (You 
also need to make sure that Siebel Documents component group is not enabled on your main Siebel 
Server.)

Enabling the Siebel Documents component group can also be performed after installation is 
complete, as described in the section �Enabling the Component Group for the Document Server� on 
page 12. 

NOTE: Whenever the Siebel Server is restarted, the Document Server must also be restarted after 
the Siebel Server has been brought up.

Make sure that you use the same SRF file on your Document Server as you use on your other Siebel 
Server. If you update one SRF file, remember to update the SRF file on all your Siebel Server 
machines, including the Document Server.
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Document Server ■  Process of Setting Up the Document Server
Installing the Siebel Server in a Heterogenous Environment
There are some special considerations for setting up the Document Server (Windows platform) when 
your main Siebel Server runs on a UNIX platform. 

There are two approaches you can use:

■ Install third-party mounting software, such as Samba, to allow the Document Server (Windows 
platform) to access the Siebel file system on the UNIX platform.

■ Disable the File System Manager Server component on the Document Server (Windows platform)

Procedures describing both these approaches are given here.

NOTE: The Siebel File System Manager and the physical file system should be on the same platform 
if no cross-platform mounting tool is used.

To set up the Document Server in a heterogeneous environment using third-party 
mounting software

1 Install third-party software, such as Samba, that will allow the Windows machine to access the 
Siebel file system on the UNIX machine.

2 Make sure that the enterprise parameter Siebel File System on the Siebel Server on the Windows 
machine points to the Windows share for the Siebel File System on the UNIX machine.

3 Make sure that the Siebel Documents component group is disabled for the Siebel Server on the 
UNIX machine.

4 Before you install the Siebel Server (the Document Server) on the Windows machine, make sure 
that the Siebel Gateway Name Server and the Siebel Server are up and running on the UNIX 
machine. 

5 During installation of the Siebel Server on the Windows machine, enable only the Siebel 
Documents and the System Management component groups. 

To set up the Document Server in a heterogeneous environment without third-party 
mounting software 

1 Make sure that the Siebel File System enterprise parameter is set to the full path of the Siebel 
File System on the UNIX machine.

2 Make sure that the Siebel Documents component group is disabled for the Siebel Server on the 
UNIX machine.

3 Before you install the Siebel Server (the Document Server) on the Windows machine, make sure 
that the Siebel Gateway Name Server and the Siebel Server are up and running on the UNIX 
machine. 

4 During installation of the Siebel Server on the Windows machine, enable only the Siebel 
Documents and the System Management component groups. 

5 On the Siebel Server (the Document Server) on the Windows machine:
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Document Server ■  Process of Setting Up the Document Server
a Disable the File System Manager Server (alias FSMSrvr) component.

NOTE: For information about re-enabling components, see Siebel System Administration 
Guide.

b In the Enterprise component definition, for the Document Server component, set the Siebel File 
System component parameter to *FSM*

c Synchronize all components.

6 Restart the Siebel Servers on the UNIX machine and on the Windows machine.

Installing Microsoft Office Applications on the 
Document Server
You must install Microsoft Office on the dedicated host machine of the Document Server.

For information about which versions of Microsoft Office are supported, see Release Notes on Siebel 
SupportWeb and System Requirements and Supported Platforms on Siebel SupportWeb for your 
Siebel application.

This task is a step in �Process of Setting Up the Document Server� on page 10.

To install Microsoft Office

1 Log on to the server machine using the same user account that the Siebel Server NT service uses. 
This user account must belong to the Administrators group. 

NOTE: The install must use the same account to be used by the NT Service. The installer 
configures COM security settings so that the installing user account has the correct permissions 
to access and launch the application. If the install uses an account other than the Siebel Server 
NT service account, errors may occur when the Document Server tries to launch the application.

2 Install Microsoft Office using a typical or complete installation. Verify that your version of 
Microsoft Office installs the Web Authoring Tools (HTML) component with the typical installation. 
If it does not, you will need to use the custom installation option and install all of the typical 
components as well as the Web Authoring Tools (HTML) component.

3 Start the applications that will be used by the Document Server. 

This forces the applications to register themselves.

4 If you use Siebel Proposals, make sure that the Microsoft Word option �Confirm conversion at 
open� option is not selected.

This option is found on the Tools menu: Tools > Options > General.

5 Close the applications.

Enabling the Component Group for the Document Server
This task is a step in �Process of Setting Up the Document Server� on page 10.
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Document Server ■  About Synchronizing Components for the Document Server
If you have not already done so during installation, you must enable the component group named 
Siebel Documents. This group contains the DocServer component, which generates Correspondence, 
Presentations, and Proposals. For more information about enabling this group, see Siebel System 
Administration Guide.

Setting MaxTasks Parameters for the Document Server
Due to Siebel design limitations, third-party Microsoft Office applications run in a single-threaded 
environment. This means the document server is only capable of processing a single document at a 
time on the server. To increase the number of documents being printed at any one time, it is 
recommended you increase the number of servers.

This task is a step in �Process of Setting Up the Document Server� on page 10.

There are two Siebel Application Object Manager parameters that need to be set:

■ MaxTasks. This parameter should be set to 1. If MaxTasks is greater than 1, an error message 
is sent to the log file as an alert. Processing of the request continues, but results are 
unpredictable when two requests arrive at the same time.

■ Honor MaxTasks. This parameter affects the queuing process and the performance of 
Document Server. For more information, see Table 2.

To set MaxTasks parameters

1 Set MaxTasks to 1.

2 Set Honor MaxTasks to TRUE.

For information about setting parameters, see the section about Siebel Application Object Manager 
parameters in the Siebel System Administration Guide.

About Synchronizing Components for 
the Document Server
This step is not specific to the Document Server, but is a required post-installation step for the server 
infrastructure. 

Table 2. Honor MaxTasks Parameter for the Document Server

Setting Behavior

TRUE All requests to Document Servers queue on the SRM_REQUEST table; requests 
are not assigned to a Document Server until one is free to take the request. (This 
is the recommended value.)

FALSE Requests are queued on the DocServer component�s internal queue. If the 
Document Server stops processing (for example, crashes) all queued processes 
on that server are lost.
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Document Server ■  (Optional) Configuration for the Document Server
To synchronize components for the Document Server
■ See general information about synchronizing components in the Siebel System Administration 

Guide.

(Optional) Configuration for the 
Document Server
This topic describes a number of optional configurations for the Document Server:

■ �(Optional) Configuring Report Generation� on page 14

■ �(Optional) Enabling HTML Generation for Correspondence� on page 14

■ �(Optional) Configuring Application Recycle Period� on page 15

■ �(Optional) Specifying the Target Server� on page 16

■ �(Optional) Enabling Additional Logging� on page 16

(Optional) Configuring Report Generation
If you plan to include report sections in proposals, you must specify the Actuate connect string. Set 
this parameter on each object manager that will be submitting document requests. The value of the 
parameter will be included in the request sent by the object manager to the DocServer. When 
DocServer begins processing the request, it will use the parameter to connect back to the object 
manager to retrieve data for the report.

To specify the Actuate connect string

1 Start the Server Manager. 

2 Modify the server parameter ActuateConnStr to contain the following information:

siebel.tcpip://gatewayserver:port/enterpriseserver/objectmgr/siebelserver 

For example, if \\gtwy is the gateway server host, Sieb01 is the Siebel Server, siebel is the 
Enterprise Server, and you want to run your proposal with report section on Siebel Call Center, whose 
object manager is SCCObjMgr, you should enter the following command:

srvrmgr> change param ActuateConnStr=siebel.tcpip://gtwy/siebel/SCCObjMgr/Sieb01 
for comp SCCObjMgr

The parameter ProposalReportTimeoutInSecond also affects the generation of reports. This is the 
time-out setting that controls how long the Document Server component will wait for a report to be 
generated. The default value is 1800 seconds.

(Optional) Enabling HTML Generation for Correspondence
By default, correspondence is only saved in document format, not in HTML format. In the My 
Correspondence Requests view, the View HTML command is unavailable, and the user cannot view 
the correspondence in HTML format. 
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Document Server ■  (Optional) Configuration for the Document Server
The server parameter DocumentServerViewHTML specifies whether the Document Server generates 
HTML versions of documents. The default value is FALSE. By default, the Document Server only 
generates documents in their native format, and not in HTML. To allow the user to display 
correspondence in HTML format, you must edit the parameter DocumentServerViewHTML to give it 
the value True instead of False. Any documents generated after the parameter is enabled is saved in 
both formats.

When you generate HTML documents, a copy of the generated document is created in HTML and 
stored in the Siebel File System. This may affect performance, and it will increase the storage space 
required in the File System. The clarity of the HTML document depends on your Office application�s 
ability to translate its native format into HTML.

Entering the following command allows generation of HTML versions of Correspondence, Proposals, 
and Presentations. 

To enable generation of HTML versions of documents 

1 Start the Server Manager. 

2 Enter the following command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed using the 
Administration - Server Configuration screen. 

(Optional) Configuring Application Recycle Period
You use the parameter MSWordLiveCount to control how often the Office applications are restarted. 

Each parameter can be set to a positive integer that specifies the number of documents to be 
processed before it shuts down and restarts the corresponding Office application. A value of 0 (the 
default) indicates that the applications will not be shut down. If the parameter value is set to any 
integer other than 0 and the Document Server fails to launch, the corresponding application will be 
shut down and then restarted again.

To change the values of these parameters

1 Start the Server Manager.

2 To change the application recycling period for Microsoft Word, which is used by Correspondence 
and Proposals, enter the following command:

Srvrmgr> change param MSWordLiveCount=5 for comp DocServer

3 To change the application recycling period for Microsoft PowerPoint, which is used by 
Presentations, enter the following command:

Srvrmgr> change param MSPPLiveCount=5 for comp DocServer
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(Optional) Specifying the Target Server
If you are running multiple Document Servers within the same enterprise, then the server 
infrastructure will route document requests to different Document Servers in order to achieve load 
balancing. 

However, it sometimes may be useful to specify that all requests be routed to one Document Server. 
For example, you can do this to help diagnose a server problem.

To route all requests to one document server 

1 Start the Server Manager. 

2 Enter the following command:

srvrmgr> change param DocumentServerName=DocSrvr1

(Optional) Enabling Additional Logging
You may want to enable additional logging. This can be helpful for debugging. 

The event logging system writes events to the log file based on the log level for each event type. The 
number you specify indicates the filtering level for logging. The default value is 3, which means that 
events with a level of 1, 2, or 3 will be logged, while events with a level of 4 or 5 will be suppressed. 
Setting the filtering level to 5 means that all events will be logged.

NOTE: In the final command on the list, the parameter must be in quotation marks, because it has 
a space in it. In the other commands, quotation marks are optional and are not included in the list.

To enable additional logging

1 Start the Server Manager. 

2 Enter the following commands: 

srvrmgr> change evtloglvl GenericLog=5 for comp Docserver

srvrmgr> change evtloglvl ProposalDebug=5 for comp Docserver

srvrmgr> change evtloglvl ProposalDetail=5 for comp Docserver

srvrmgr> change evtloglvl PresentationDebug=5 for comp Docserver

srvrmgr> change evtloglvl PresentationDetail=5 for comp DocServer

srvrmgr> change evtloglvl DocServerDebug=5 for comp DocServer

srvrmgr> change evtloglvl DocServerDetail=5 for comp DocServer

srvrmgr> change evtloglvl CorrespDebug=5 for comp DocServer

srvrmgr> change evtloglvl CorrespDetail=5 for comp DocServer

srvrmgr> change evtloglvl MSProjectDebug=5 for comp DocServer

srvrmgr> change evtloglvl "MS ProjectDetail"=5 for comp DocServer
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Document Server ■  (Optional) Configuration for the Document Server
For more information about event logging, see System Monitoring and Diagnostics Guide for Siebel 
Business Applications.
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3 Correspondence
This chapter is about administering and using Siebel Correspondence. It includes the following 
topics:

■ �About Siebel Correspondence� on page 19

■ �Scenario for Correspondence� on page 21

■ �Process of Setting Up and Using Correspondence� on page 22

■ �Creating and Updating the SIEBEL.HTML File� on page 22

■ �Creating Correspondence Templates in Microsoft Word (Admin and End User)� on page 23

■ �(Optional) Inserting Files into Correspondence Templates� on page 25

■ �Creating Correspondence Template Records in the Siebel Application� on page 26

■ �Generating Correspondence (End User)� on page 27

■ �Configuring Additional Merge Fields For Correspondence Templates� on page 29

For information about the Documentation Server and other software that is required for Siebel 
Correspondence, see Chapter 2, �Document Server.� 

About Siebel Correspondence
Siebel Correspondence allows employees and partners to generate correspondence from any location 
with access to the Web. It also makes it easy for them to direct correspondence to fulfillment centers 
that print and mail it, so they can produce and send correspondence even if they are on the road and 
do not have access to a printer. 

For example, if sales representatives want to do mass mailings to customers in cities where they are 
giving presentations, Siebel Correspondence allows them to log on from any location where they 
have Web access. Then they can create personalized form letters to invite customers in a specific 
city to a specific presentation, and direct these letters to be printed and mailed by a fulfillment 
center. 

First, an administrator creates templates (usually form letters and labels) that employees and 
partners can use for their everyday correspondence. Then, employees and partners can 
automatically generate correspondence based on this template and on data from the Contact 
business component.
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About Correspondence Templates
Siebel correspondence templates are created and edited in Microsoft Word (DOC file format). 
Correspondence templates contain fixed text and one or more merge fields. The merge fields are 
placeholders that are populated with variable information from your Siebel database, such as a 
Contact�s name and address, when users generate a correspondence for one or more recipients.

Users can create their own personal templates, and administrators can create correspondence 
templates for users. 

About Correspondence with Multiple Languages and Locales
The fixed text of each correspondence template is written using specific locale conventions and 
language. In order to support Global Deployment, the author of the correspondence template can 
explicitly indicate the locale and language using the Locale and Language fields in the 
correspondence template record. The Document Server then uses these settings to substitute 
correctly localized data into the merge fields of the correspondence template. The following types of 
fields are affected:

■ MLOV fields

■ Global data fields

■ Locale-sensitive fields, such as dates and currencies

Correspondence Terms Defined
Definitions of terms used in this chapter are given in Table 3.

Table 3. Correspondence Terminology

Term Definition

Correspondence template This is a Microsoft Word file (DOC or HTM). It usually contains one or 
more merge fields. It should not contain code (including field codes 
such as ASK) or macros. 

Typically, this file contains a form letter where the address and 
salutation are merge fields that can be automatically filled in for 
multiple recipients.

Label template The label template is a correspondence template specifically for a 
mailing label. Label templates are created much the same way as 
other correspondence templates, but are generated using the 
Generate Label command instead of the Generate Correspondence 
command. 

Insertion template This is a Word, text, or HTML file. It may not contain any merge fields.

Personal correspondence 
template

A correspondence template that users create for their own use. It 
cannot be used by others, although the administrator can view, edit, 
and delete it.
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Scenario for Correspondence
This scenario provides an example of a business process performed by an administrator and sales 
representatives managing correspondence. Your company may follow a different process according 
to its business requirements.

A company has already installed the Documentation Server and wants to make Siebel 
Correspondence available to its sales representatives so that they can send literature with 
personalized cover letters to customers who request product information.

The administrator sets up the cover letter (correspondence) template and mailing label template that 
the sales representatives will use. 

When customers request product literature, the sale representatives generate personalized cover 
letters and mailing labels and specify what literature needs to be included in the mailing. The 
customers� name and address details are taken from the Contacts list in the Siebel database.

The sales representatives review and sometimes modify the cover letter before submitting the 
correspondence to a fulfillment center where it is printed and mailed. The changes made to the cover 
letter can be saved back to the Siebel file system by saving the document.

Correspondence template 
record

This is the record in the Siebel database that contains the 
correspondence template. (The correspondence template is stored in 
the Siebel File System.) These records appear in the Correspondence 
Templates and the Personal Templates views.

Correspondence record This is the record in the Siebel database that contains the generated 
correspondence. A correspondence record must have a 
correspondence template record associated with it. In addition, it can 
have a label template record associated with it.

Merge field Merge fields are placeholders in the correspondence template that 
are populated with information from records in the Siebel database, 
such as a contact�s last name. (These are also called mail merge 
fields.)

Merge data Data from the Siebel database that is copied into the merge fields 
when correspondence is generated. 

SIEBEL.HTML file Lists the database columns used as merge fields in the most recently 
generated correspondence. (The file is updated each time 
correspondence is generated.)

When correspondence templates are created in Microsoft Word, the 
SIEBEL.HTML file is used as the data source file.

Table 3. Correspondence Terminology

Term Definition
Siebel Correspondence, Proposals, and Presentations Guide Version 7.8 21



Correspondence ■  Process of Setting Up and Using Correspondence
Process of Setting Up and Using 
Correspondence
To set up and use correspondence, perform the following tasks:

■ �Creating and Updating the SIEBEL.HTML File� on page 22

■ �Creating Correspondence Templates in Microsoft Word (Admin and End User)� on page 23

■ �(Optional) Inserting Files into Correspondence Templates� on page 25

■ �Creating Correspondence Template Records in the Siebel Application� on page 26

■ �Generating Correspondence (End User)� on page 27

■ �Configuring Additional Merge Fields For Correspondence Templates� on page 29

Creating and Updating the SIEBEL.HTML 
File
The SIEBEL.HTML file is the data interface between the Siebel application and Microsoft Word. During 
the document generation process, the Document Server exports merge data into the SIEBEL.HTML 
file. Microsoft Word then reads this file and inserts the data into the merge fields in the 
correspondence template.

When you create correspondence templates, the SIEBEL.HTML file that you generate from a blank 
template is used as the data source file, determining which merge fields can be added to the 
correspondence template. 

Figure 1 on page 22 shows a portion of a SIEBEL.HTML file. The column headers represent database 
fields and the cells contain the values of those fields for the mostly recently generated 
correspondence.

Administrators can augment the set of merge fields available using Siebel Tools. For information, see 
�Configuring Additional Merge Fields For Correspondence Templates� on page 29.

The SIEBEL.HTML file is not installed (out of the box). It is created in the \REPORTS directory the first 
time correspondence is generated. 

Creating or updating the SIEBEL.HTML file should be carried out in the following situations:

Figure 1. Part of the SIEBEL.HTML File
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■ By the administrator before correspondence templates are created for the first time (in order to 
create the SIEBEL.HTML file).

■ By end users who use disconnected Siebel Mobile Web Clients and want to create personal 
correspondence templates on their local machines (in order to create the local SIEBEL.HTML file).

■ By the administrator after additional merge fields have been configured. (See �Configuring 
Additional Merge Fields For Correspondence Templates� on page 29.)

This task is a step in �Process of Setting Up and Using Correspondence� on page 22.

To initially create (or update) the SIEBEL.HTML file by generating a blank 
correspondence template

1 In Microsoft Word, create and save a blank document. 

2 Navigate to the Correspondence screen > Personal Templates view.

3 In the Templates list, create a new record and, in the Template field, specify the blank 
correspondence template that you created in Step 1.

4 On the link bar, click My Correspondence Requests.

5 In the Correspondence list, create a new record.

6 In the Template field, select the template record that you created in Step 3.

7 Click Generate.

The SIEBEL.HTML file that is created in the \REPORTS directory contains all the database columns 
that are for use as merge fields.

Creating Correspondence Templates in 
Microsoft Word (Admin and End User)
There are a number of starting points for creating a correspondence template in Microsoft Word:

■ An existing Microsoft document, for example a company form letter. (Make sure that the 
document does not contain any merge fields not defined in SIEBEL.HTML, or any code, or any 
macros.)

■ A new, blank Microsoft Word document.

Two procedures are given in the following section: one for Microsoft Word 2000 and one for Microsoft 
XP. Both procedures explain how to add merge fields (defined in the SIEBEL.HTML file) to Microsoft 
Word documents.

This task is a step in �Process of Setting Up and Using Correspondence� on page 22.

To create a template and add merge fields in Microsoft Word 2000

1 Copy the current version of the SIEBEL.HTML file to your local hard drive, for example, to the My 
Documents directory.
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2 In Microsoft Word, create a new document or open the document that you want to use as the 
starting point for your correspondence template.

3 From the Tools menu, choose Mail Merge. 

4 In the Mail Merge Helper dialog box, click Create > Form Letters. (Or, if you are creating a label 
template, choose Create > Mailing Labels.)

5 Click Active Window to use the current document.

6 In the Mail Merge Helper dialog box, click Get Data > Open Data Source and open the 
SIEBEL.HTML file.

7 Close the Mail Merge Helper dialog box.

If the template file does not yet contain merge fields, an information box states this. Click Edit 
Main Document in the box.

8 Add and edit the text in the document as required.

9 Add merge fields as required:

a Position the insertion point where you want the merge data to appear.

b Click the Insert Merge Fields button and insert the appropriate merge field. 

10 When you have finished adding merge fields, exit from mail merge mode:

a Click the Mail Merge Helper button on the Mail Merge toolbar. 

b In the Mail Merge Helper dialog box, click Create > Restore to Normal Word Document.

CAUTION: If you do not restore the document to normal mode, the Document Server can 
hang when correspondence is generated.

c Click Yes to continue.

d Close the Mail Merge Helper dialog box.

11 Save the file with a .doc extension and close.

To create a template and add merge fields in Office XP

1 Copy the current version of the SIEBEL.HTML file to your local hard drive, for example, to the My 
Documents directory.

2 In Microsoft Word, create a new document or open the document that you want to use as the 
starting point for your correspondence template.

3 From the Tools menu, choose Letter and Mailings > Show Mail Merge Toolbar.

4 In the toolbar, click the Main document setup button.

5 In the Main Document Type dialog box, select Letters. (Or, if you are creating a label template, 
select Labels.)

6 On the Mail Merge toolbar, click the Open Data Source button and open the SIEBEL.HTML file.

7 Add and edit the text in the document as required.

8 Add merge fields as required:
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a Position the insertion point where you want the merge data to appear.

b Click the Insert Merge Fields button and insert the appropriate merge field. 

9 When you have finished adding merge fields, click the Main document setup button on the Mail 
Merge toolbar and, in the Main Document Type dialog box, select Normal Word Document.

CAUTION: If you do not restore the document to normal mode, the Document Server can hang 
when correspondence is generated.

10 Save the file with a .doc extension and close.

(Optional) Inserting Files into 
Correspondence Templates
The Siebel Correspondence file insertion feature allows you to insert one or more files (called 
insertion templates) into a correspondence template. These insertion templates can be in Word, text, 
or HTML files.

You can add insertion templates containing generic content into one or many correspondence 
templates. For example, you can create a company description in a separate insertion template and 
then include it in several correspondence templates. If the description changes, you only have to 
modify the insertion template instead of every correspondence template.

You may add as many insertion templates into a correspondence template as necessary. The file 
name for each insertion template must be unique and each insertion template must be inserted into 
the correspondence template independently. Insertion templates may not be nested. For example, 
you may insert File1.doc, File2.doc, and File3.doc into a template named FollowUp.doc. But, you may 
not insert File1.doc into File2.doc, and then insert File2.doc into FollowUp.doc.

TIP: Remember to create correspondence template records for your insertion templates as well as 
for your correspondence templates.

This task is a step in �Process of Setting Up and Using Correspondence� on page 22.

To add an insertion template into a correspondence template

1 If it does not already exist, create the insertion template using Microsoft Word. (Make sure that 
your insertion template does not contain merge fields, code, or macros.)

2 Open the correspondence template to which the insertion template is to be added.

3 Insert a separate line with the following command at the location where the insertion template 
is to be displayed:

[[File Name]] 

Do not include the file extension. For example, if insertion template is File1.doc, enter [[File1]].

4 Save the file with a .doc extension and close.
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Creating Correspondence Template 
Records in the Siebel Application
In order to make the correspondence templates available to the Siebel application, they must be 
added to the Siebel File System by creating a correspondence template record. There are two views 
in the Siebel application where correspondence template records can be added:

■ Administration - Document screen > Correspondence Templates view. This view is used by the 
administrator who creates correspondence templates for multiple employees.

■ Correspondence screen > Personal Templates view. This view is used by employees who create 
correspondence templates that are only for their personal use.

TIP: Remember to create correspondence template records for your insertion templates as well as 
for your correspondence templates.

NOTE: You should always perform system administration tasks, such as administration of 
correspondence templates, against the server database. Although you can perform these tasks 
against your local database and synchronize, doing so has the potential to cause errors, including 
data conflicts. In addition, performance problems can result from a large local database, and from 
routing large numbers of transactions. 

This task is a step in �Process of Setting Up and Using Correspondence� on page 22.

To add a template record

1 Navigate one of the following: 

■ Administration - Document screen > Correspondence Templates view

■ Correspondence screen > Personal Templates view

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Template 
Name

The name of a correspondence template, label template, or insertion template.

Language The language used by the Document Server to render merge fields based on 
MLOV and Global Data Business Component fields.

Locale The locale used by the Document Server to format merged data based on locale-
sensitive business component fields, such as phone numbers. If no locale is 
specified, the application�s locale is used.

Personal A check mark in this field indicates that the correspondence template is a 
personal correspondence template, which can only be used by the creator. 

(This field appears in the Administration - Document screen, but not in the 
Correspondence screen.)
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Generating Correspondence (End User)
End users generate correspondence using the administrator-defined correspondence templates or 
the personal templates that they create themselves. 

Using Microsoft Word, they can edit the template for a selected correspondence record (Modified 
Template), and they can edit the generated correspondence document. The edits made to the 
correspondence document can be saved back to the Siebel File System by saving the merged word 
document.

Literature can be attached to the correspondence. (For general information about Literature, see 
Applications Administration Guide.) 

This task is a step in �Process of Setting Up and Using Correspondence� on page 22.

To generate correspondence

1 Navigate to the Correspondence screen > My Correspondence Requests view.

NOTE: You can navigate to this screen from anywhere in the application by choosing File > Send 
Letter from the application-level menu. 

2 In the Correspondence list, create a new record and complete the Template field.

Some fields are described in the following table.

Active Indicates whether or not the correspondence template is available for use.

NOTE: It is recommended that you make the template inactive before 
modifying it to prevent other users from attempting to use it while you are 
modifying it. After you have finished your modifications, check the Active field 
again. 

Request Allows users to request templates from the server. When a check mark appears 
in this field, the document is retrieved during the next synchronization session. 
This field applies only to Siebel Remote users.

Update File 
(or Update)

A check mark in this field indicates that mobile users will have their copy of the 
template to be updated automatically each time the original file is changed

(This field appears in the Administration - Document screen, but not in the 
Correspondence screen.)

Field Comments

Status The correspondence status. Values include Submitted, Pending, and 
Completed. This field is used for Fulfillment. For more information, see 
Chapter 6, �Fulfillment Centers.� 

Template Specify the name of the correspondence template that you want to use 
for the correspondence. 

Field Comments
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3 In the Recipients list, add records for the contacts or employees who you want to receive the 
correspondence.

Specifying large numbers of recipients affects performance and time required to generate the 
correspondence.

If you create a new record in the Add Recipients dialog box, the individual is added to the 
Contacts list.

4 If you want to include literature in the correspondence, add records to the Enclosures list.

Literature must be of type Sales Tool* and cannot be marked as internal.

NOTE: If you are working in a Mobile Web Client environment (remote), you must have the 
literature files available in your local environment. If the Local check box is selected, you can 
work with the file in a remote environment. To download the file from the server the next time 
you synchronize, select the Request check box for the Literature record in the Enclosures list. 

5 If you want to make edits to the correspondence template that will apply to all recipients but only 
for this correspondence record, edit the file in the Modified Template field. 

This file (like the correspondence template) is stored in the Siebel File System.

6 Click Generate.

Modified Template See Step 5.

Document Status See Step 7.

Fulfillment Center Specify a fulfillment center that can produce and distribute the document 
and enclosures on your behalf. For more information, see Chapter 6, 
�Fulfillment Centers.�

Generated 
Document

After the correspondence has been generated, you can drill down on the 
hyperlink in this field to preview the document merged with the name 
and address of the selected recipient in the Recipients list.

Generated Label Drill down on the hyperlink in this field to preview the label merged with 
the name and address of the selected recipient in the Recipients list.

Label Status The system status for the label during generation. Default values include 
In Progress, Generating, Completed, and Failed.

Label Template The name of the label template defined by your company and created by 
your Siebel administrator, or your personal template.

Opportunity Specify the name of the opportunity associated with the correspondence. 
Drill down on the hyperlink in the Opportunity field to open the 
Opportunity detail form.

Field Comments
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7 For Web Client (network connection): Because the Document Status field does not automatically 
update, click the Update button to refresh the record and see the current status of your 
correspondence. The following table lists the status values you may see.

8 For Web Client (network connection): Drill down on the Merged hyperlink in the Generated 
Document field.

Or, if you do not have Microsoft Word installed locally and do have enabled HTML generation, click 
the menu button and choose View (HTML) to display a document in your Web browser.

NOTE: If you are using the Mobile Web client, the generated correspondence opens 
automatically.

9 (Optional) Make edits to individual pages of the generated correspondence and save the changes 
back to the Siebel file system before printing, batch printing, or submitting to a fulfillment center.

■ For information about fulfillment centers, see Chapter 6, �Fulfillment Centers.�

■ For information about batch printing, see �About Batch Printing� on page 97.

10 (Optional) Generate labels for the correspondence:

a Complete the Label Template field.

b From the menu button, choose Generate Label.

For information about printing correspondence, see Chapter 6, �Fulfillment Centers.�

Configuring Additional Merge Fields For 
Correspondence Templates
The exported data is taken from two places:

■ If the correspondence was created from a view based on service requests, the data is taken from 
the Service Request Recipient business component.

■ If the correspondence was created from the Correspondence list view, or from a view not based 
on service requests (such as the Opportunities screen), the data is taken from the Recipients 
business component.

Status Meaning

In Queue Request sent to available document server.

Generating Document server is creating the Word merge document.

Completed Document is available and can be accessed from the Generated Document field.

Failed Document server encountered errors. Check the Document Error and Label 
Error fields for error messages.
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New fields in the Recipients business component are restricted to those based on columns in the 
S_CONTACT table or those obtained through join relationships. Joins can be added for tables that 
have a master-detail relationship with S_CONTACT, where S_CONTACT is the detail table. You need 
to add the join to the Recipients business component.

New fields in the Service Request Recipient business component are restricted to those based on 
columns in the S_CONTACT table, the S_SRV_REQ table, or columns available through joins to these 
tables.

Table 4 summarizes the contents of the two business components and the contexts in which they are 
used. For more information on adding fields, see Developing and Deploying Siebel eBusiness 
Applications and Configuring Siebel Business Applications.

To configure an additional merge field

1 In Siebel Tools, add the new field to either the Recipients business component or the Service 
Request Recipient business component.

CAUTION: Make sure that the field�s database column name does not exceed 38 characters. 
(This is because Microsoft Word cannot handle merge fields with long names.)

2 Add the name of the new field to the business component�s user property called Export Field #, 
where # is an integer. 

If necessary, you can create additional user properties by incrementing the integer.

3 Update the SIEBEL.HTML file (�Creating and Updating the SIEBEL.HTML File� on page 22) before 
creating a correspondence template containing the new field.

NOTE: You can have up to 63 merge fields in the SIEBEL.HTML file; Microsoft Word does not display 
fields beyond this limit.

Table 4. Summary of Merge Fields Sources and Uses

Source Business 
Component Source Tables Used In

Recipients ■ S_CONTACT

■ Joins with tables that have a 
master-detail relationship 
with S_CONTACT (with 
S_CONTACT as the detail 
table).

Correspondence created:

■ Directly in the Correspondence 
List View.

■ From any view not based on 
service requests.

Service Request 
Recipient

■ S_CONTACT

■ S_SRV_REQ

■ Joins with tables that have a 
master-detail relationship 
with one of these two (with 
S_CONTACT or S_SRV_REQ 
as the detail table).

Correspondence created from views 
based on service requests.
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This chapter is about administering and using Siebel Proposals. It includes the following topics:

■ �About Siebel Proposals� on page 31

■ �Process of Creating Proposal Templates� on page 32

■ �Scenario for Generating Proposals (End User)� on page 54

■ �Process of Generating Proposals (End User)� on page 54

■ �Sample Proposal Data: Field Mappings and Templates� on page 61

For information about the Documentation Server and other software that is required for Siebel 
Proposals, see Chapter 2, �Document Server.� 

About Siebel Proposals
Siebel Proposals allows your sales representatives to create proposals (and other types of 
documents) based on templates that you create in Microsoft Word.

Traditionally, sales representatives create proposals by starting with a proposal that worked in the 
past and then modifying it for the current prospect. Sales representatives must not only change such 
basic information as the customer�s name, but also possibly restructure the proposal so that it fits 
the new prospect�s unique needs. For example, the original proposal may have been focused on price, 
whereas the new prospect is more concerned with other decision criteria, such as speed or extra 
functionality. 

With Siebel Proposals, after the proposal administrator has created the right templates, the sales 
representative can click one button to build the correct proposal for a specific account or opportunity. 
Siebel Proposals uses information that sales representatives have entered in the early stages of an 
opportunity to create the proposal. 

Sales representatives can add deal-specific information to the proposal without worrying about 
formatting or presentation. Using the Proposal Library, sales representatives can find any additional 
information and automatically insert it into the proposal. 

NOTE: The Siebel proposal document engine is also used to create agreement documents. 
Administrators who create the agreement templates can follow the steps in this chapter for creating 
proposals. Users can then select the agreement template and generate an agreement document.

System Requirements for Siebel 
Proposals
Certain system requirements must be met to use Siebel Proposals.
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System Requirements for the Siebel Web Client
To use Siebel Proposals, you must have:

■ All of the components that are required to use the Siebel application installed on the server, such 
as a Siebel Server and a Web Server. 

■ The Document Server installed on one or more Windows machines.

■ Microsoft Office installed on the Document Server machine.

NOTE: If you are deploying the Siebel Server in UNIX and want to use Siebel Proposals, a separate 
Windows machine is required for the Document Server.

Siebel Proposals uses the Document Server, which is a component of the Siebel Server that lets users 
on the Web work with Word documents that are on the server. 

Your employees or partners who use Siebel Proposals need:

■ A Web browser to use the product.

■ (Optional) Microsoft Office to edit documents.

For information on the Web browsers that are supported by Siebel applications, see System 
Requirements and Supported Platforms on Siebel SupportWeb.

System Requirements for the Siebel Remote Web Client
Siebel Proposals is available for the Siebel Remote Web Client as well as for the Siebel Web Client. 
The user interface for Proposals is identical in the Siebel Remote Web Client and the Web Client. 

Siebel Remote Web Client processes requests to generate documents locally, so that field sales 
representatives can generate correspondences, proposals, and presentations while traveling. To run 
Siebel Proposals on the Remote Web client, you must have Microsoft Office installed on the same 
machine as the Remote Web Client. 

Process of Creating Proposal Templates
To create proposal templates, perform the following tasks:

■ �Creating Proposal Template Documents in Microsoft Word� on page 33. Create Microsoft Word 
documents. To create the documents needed by the template, you must write the text and insert 
bookmarks for such variables as company, contact name, and address.

■ �Creating Records for Proposal Templates� on page 39. Use your Siebel application to create a 
single record for the template.

■ �Defining Proposal Template Sections� on page 40. Create the proposal structure. Specify which 
sections the proposal should contain.

■ �Adding Components to Proposal Template Sections� on page 46. Specify which components each 
section should contain.

■ �Using Conditions in Proposal Templates� on page 47. Use conditions in sections or components. 
Optionally, you can add conditions to specify that sections or components are included in the 
proposal only under certain circumstances.
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■ �Defining Proposal Field Mappings� on page 48. Specify which Siebel objects correspond to each 
bookmark in your Word component documents. You also specify the name of this mapping in the 
template record.

■ �Associating a Mapping with a Proposal Template� on page 51. Associate the mapping with a 
template to make it apply to all the components in that template.

■ �Creating the Proposal Library� on page 51. In this optional step, which can be performed at any 
time, you create a separate library of documents that sales representatives can draw upon to 
customize their proposals.

■ �Allowing Users to Display Proposals in HTML Format� on page 53. Update settings on the document 
server to allow end users to view proposals in HTML.

Creating Proposal Template Documents 
in Microsoft Word
The first step for creating proposal templates is to create documents in Microsoft Word. These 
documents consist of one style document and multiple component documents, as shown in Figure 2.

Figure 2. Word Documents That Can Make Up a Proposal Template
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The components shown in Figure 2 are only examples. You could have other components, such as a 
table of contents or a set of collateral, and you could omit the quotes or product descriptions, for 
example. However, a template must have a style document and one or more component documents. 

NOTE: See Release Notes on Siebel SupportWeb for information about which versions of Microsoft 
Word are supported.

To create the template documents, you perform the following tasks:

■ Planning the template. Decide what components the template should have.

■ Creating the style document. Create the document that gives all the template�s components 
a standard format. 

■ Creating the component documents. Create a document for each component of the template.

These tasks are a step in �Process of Creating Proposal Templates� on page 32. 

Planning the Proposal Template
Before you create the documents in Word, you must determine how the proposal should look and 
what type of information it should contain. 

Begin by looking at previous successful proposals to see what sections they included. For example, 
did they all have a cover letter, an executive summary, and a quote? Also, look at the documents 
your company currently has on hand, and the customer questions these pieces answer. Then decide 
how to organize your information. What topics could be standard across all proposals? What topics 
are specific to certain proposals? What is the best order for the pieces in the proposal you are 
creating? Finally, decide what fields to insert to customize their proposals (for example, contact 
name, account name, and industry). You will use this information to create bookmarks in your Word 
documents.

As part of your planning, you should look at the sample templates that come with Siebel Proposals, 
which are described in �Sample Proposal Data: Field Mappings and Templates� on page 61.

NOTE: Proposals use fields from only one business object. If you want to include additional fields, 
you must use Siebel Tools to add the business components that include these fields to the business 
object that is the basis of the proposal.

Creating a Styles Document
After you plan your template, you work on the styles document for the template. This Word document 
will define the layout of your proposal and may include such things as headers, footers, your logo, 
and special margins.

The layout options you specify will automatically be applied to all the components used in the 
proposal.

NOTE: Do not type any content into this document. The content will come from the individual 
component documents that you will create later.
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To set up styles for your template

1 Create a new document in Microsoft Word. 

2 Set up margins, headers, footers, fonts, and other layout options for your template.

3 When you are finished creating styles, save the file:

■ Choose a name that uses only alphanumeric characters. 

■ Use the .doc extension for Microsoft Word.

4 Close the file.

Creating Components for Proposal Templates
The next step in developing your template is to create components, which are the text pieces that 
make up the body of your proposal. 

A component is a Microsoft Word document that includes standard text and personalized data. For 
example, a cover letter component includes your standard cover-letter text and personalized data 
such as the name and address of the contact to whom the letter is addressed.

To create a component, you type the standard text and then create bookmarks, or Microsoft Word 
placeholders for custom data. When a sales representative generates a proposal, these bookmarks 
will be replaced with data from the Siebel application. 

NOTE: The following procedures may vary slightly, depending on your version of Microsoft Word. 
Microsoft Word 2003 is supported for Siebel 7.5.3, 7.7.2 and 7.8. If you are using Microsoft Word 
2003, begin with the procedure �To create a component with bookmarks in Microsoft Word 2003� on 
page 35. If you are not using Microsoft Word 2003, begin with the procedure �To create a component 
with bookmarks in Microsoft Word versions other than 2003� on page 37.

To create a component with bookmarks in Microsoft Word 2003

1 In Microsoft Word, create a new document and do one of the following:

a Select an item to which you want to assign a bookmark.

b Click where you want to insert a bookmark.

2 From the Insert menu, choose Bookmark.
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3 In the Bookmark dialog box, in the Bookmark name field, enter or select a name for the 
bookmark.

NOTE: Bookmark names must begin with a letter and may contain numbers if desired. They 
cannot include spaces. You can use the underscore character to separate words.

4 Click Add.

5 From the Insert menu, choose Field.

6 From the Categories drop-down list, click Links and References, and then click Ref in the Field 
names list.

7 Click the Field Codes button.

REF appears in the Field codes field.

8 In the Field codes field, enter the name of your bookmark after REF. 

For example, you might type Company for company name, so that the Field codes field contains: 

REF Company

NOTE: If the text inserted into a bookmark contains double quotes ("), the inserted text will 
automatically be preceded by a backslash (\). If you do not want the backslash to appear in the 
inserted text, change the double quotes to single quotes in the Siebel software.
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9 Note the name of the bookmark; you will need it when you map the bookmark to a Siebel field 
name.

10 Select the Preserve formatting during updates check box if you want to maintain the format of 
the merged text.

11 Click OK to insert the field. 

12 Repeat Step 2 on page 35 through Step 11 to add bookmarks for every field you want to insert in 
the text. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

13 Save the component document as a DOC file.

To create a component with bookmarks in Microsoft Word versions other than 2003

1 In the Microsoft Word document, enter the standard text that belongs in this component.
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2 Place the cursor where you want to create a bookmark, and choose Insert > Field. 

3 Click Links and References in the Categories list, and then click Ref in the Field Names list.

REF appears in the Description field.

4 In the Comments box, enter the name of your bookmark after REF. 

For example, you might type Company for company name, so that the Comments box contains: 

REF Company

The bookmark name must begin with a letter; it cannot begin with a number.

NOTE: If the text inserted into a bookmark contains double quotes ("), the inserted text will 
automatically be preceded by a backslash (\). If you do not want the backslash to appear in the 
inserted text, change the double quotes to single quotes in the Siebel software.

5 Note the name of the bookmark, because you will need it when you map the bookmark to a Siebel 
field name.

6 Select the Preserve formatting during updates check box if you want to maintain the format of 
the merged text.

7 Click OK to insert the field. 

In your document, the following message appears:

Error! Reference source not found.

This message is Word�s normal bookmarking convention. The error text will be replaced by 
appropriate data at the time of draft generation.

Type the name of your 
bookmark after REF.
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8 Repeat Step 2 on page 38 through Step 7 to add bookmarks for every field you want to insert in 
the text. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

9 Save the component document as a DOC file.

Creating Records for Proposal Templates
After you have created your template documents in Word, you can use Siebel Proposals to specify 
how they are assembled in the template. 

This task is a step in �Process of Creating Proposal Templates� on page 32. 

To create a record for the proposal template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name Enter a name for the template. 

Default If you want this template to be the default proposal template, select this 
check box. When the user clicks Auto Proposal, Siebel Proposals uses the 
default template if there are no decision issues that match the theme of a 
proposal. You can select only one Opportunity Proposal default and one 
Account Proposal default.

Category Select one of the following types of templates:

■ Opportunity Proposal. These templates are available only when you 
are working with Opportunities. 

■ Account Proposal. These templates are available only when you are 
working with Accounts.

■ Agreement. These templates are available when you are working with 
Siebel Professional Services Agreements.

■ Quote. These templates are available only when you are working with 
Quotes.

■ Order. These templates are available only when you are working with 
Orders.

Mapping Name Used to indicate the group of bookmark fields to be used with this 
template. Leave this field blank until you create a mapping.
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Defining Proposal Template Sections
After you have created your Word documents and a record for your template, define the structure of 
your proposal template.

A proposal is made up of sections, which divide and subdivide your proposal. Depending on your 
needs, a single section might contain multiple components or a single component.

The type of a section depends on the nature of the data it contains. For example, file sections contain 
documents, chart sections reference Siebel charts, report sections reference Siebel reports, and so 
on.

You define the structure of the proposal template by creating sections in the Administration - 
Document screen > Proposal Templates view, which are associated with the template record you 
created for this template. You must create top-level sections. Optionally, you can add subsections to 
these. Your proposal structure can have multiple levels of sections, because a subsection can contain 
other subsections.

These tasks are a step in �Process of Creating Proposal Templates� on page 32. 

Creating Top-Level Sections for Proposal Templates
First, you must create top-level sections. 

To create top-level sections

1 Navigate to the Administration - Document screen > Proposal Templates view. 

Template File 
Name

The Word template document. (This is the style document.)

Theme If you want to associate the template with a particular decision issue, click 
the select button to open the Pick Decision Issue dialog box and then pick 
a theme. When you give your proposal template a theme, you associate it 
with a particular decision issue that is important for your opportunity. 
When a proposal theme matches the number one decision issue for the 
current opportunity, Siebel Proposals automatically selects the correct 
template when the user clicks Auto Proposal. Users can also select a theme 
template if they want.

Because accounts and agreements are not related to decision issues, the 
Theme field is not applicable for Account Proposal, Agreement, Quote, or 
Order templates. It is used only for Opportunity Proposal templates.

Description Enter a description of the template.

Language The language in which the template was written.

Locale Only the templates specific to this locale will be shown.

Field Comments
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2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template record 
that you created for this proposal.

The Sections folder appears in the Explorer list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, create a new record.

5 In the Name field, enter a name for the section, which will not appear in the proposal itself.

6 In the Sequence field, specify the order in which this section should appear in the proposal.

7 In the Section Type field, indicate the type of section you are creating. 

The following table describes the section types available.

8 Complete the fields applicable to your section type. 

Table 5 describes the fields that you should complete for each type of section.

Type Comments

Chart Inserts a Siebel chart. The chart can be placed in the left margin, right 
margin, or centered, and you can change the x, y, and z axes. 

File Contains only proposal text in DOC or TXT format.

Locator Pulls in documents from the Siebel Encyclopedia. For example, if you create 
a locator section, Siebel Proposals can dynamically pull in documents from 
the encyclopedia that are related to the products the opportunity is 
interested in. For instance, if you want the proposal to dynamically insert 
text related to the products on the opportunity, use a locator. The file types 
must be DOC, TXT, or RTF. If more than one marketing document meets the 
locator criteria you specify, Siebel Proposals inserts each.

Organization 
Chart

Creates a slide and pulls in organization charts for the account or 
opportunity associated with the template. Charts are automatically 
centered.

Report Dynamically inserts a Siebel report (such as Siebel Quote). 

When inserting reports, the Proposal engine converts the Actuate report to 
HTML and inserts the HTML version as a table in your proposal. When 
designing reports to be included in Siebel Proposals, you may want to review 
headers and footers, because HTML sometimes crops these.

Only Actuate reports can be included. Microsoft Access reports cannot be 
included.

Table Pulls Siebel application data into a table format. You select fields to be 
included, the sequence of the fields, and the column length. By selecting a 
table section, you also allow creation of a related table section. See �Adding 
Related Table Subsections to Proposal Templates� on page 45.
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9 Repeat Step 4 on page 41 through Step 8 to add all the top-level sections that are needed.

Table 5. Selected Fields in the Proposal Template Administration View

Section Type Field Comments

All Condition Conditions can be applied to all section types. For 
information about conditions, see �Using Conditions in 
Proposal Templates� on page 47.

File N/A Only the Condition field is applicable.

Chart Business Object The Siebel business object from which the chart information 
is coming (for example, Opportunity). Select from the 
Business Objects dialog box, which lists all available Siebel 
business objects.

Chart or Table 
Name

The name of the chart applet you want to insert into this 
section (for example, �Opportunity Chart Applet - Current 
Opportunity Analysis�). The list contains all available 
applets.

Search Spec Any search criteria you want to use to restrict data for the 
chart. For example, Revenue > 500000.

Width How wide the chart should be in the proposal document. The 
default width is 400 pixels. 

Height How high the chart should be in the proposal document. The 
default height is 300 pixels. 

Category With charts that provide multiple X-axis options, this field 
allows you to set the option to use for the X-axis. For 
example, in the Lead Analysis by Rep chart, the X-axis can 
be Sales Representative or Quality.

Function With charts that provide multiple Y-axis options, this field 
allows you to set the option to use for the Y-axis. For 
example, in the Lead Analysis by Rep chart, the Y-axis can 
be Number of Opportunities, Opportunity Revenue, or 
Average Opportunity Revenue.

Series This field allows you to set the Z-axis you wish to use for 
charts that provide multiple Z-axis options.

Chart Location Location of the chart on the proposal page: Left, Right, or 
Center. Any text components you include in your chart 
section will wrap around the chart. For example, if you put 
your chart on the left, the text component will be inserted to 
the right of the chart.
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Locator Information 
Retrieval 
Method

Select the relationship to use to find literature. For example, 
Oppty Competitor Lit, which is the literature on competitors 
associated with the opportunity.

Retrieved 
Literature 
Category

Indicate the type of literature you are looking for (for 
example, brochures, or specification sheets). This helps you 
to filter out the documents from the encyclopedia that you 
want to include in the proposal. 

Organization 
Chart

Business Object The Siebel object from which the information is taken. Select 
from the Business Objects dialog box, which contains all 
available business objects from your repository. 

Chart or Table 
Name

The name of the applet that contains the organization chart 
data. For example, the Opportunity Organization Analysis 
applet.

Report Business Object The Siebel business object from which the report 
information is coming (for example, Opportunity). Select 
from the Business Objects dialog box, which lists all 
available Siebel business objects. For example, to include a 
quote report in your proposal, you would select Quote.

Report Name The name of the report you want to insert in this section. 
Select from the Reports dialog box, which shows all available 
reports. For example, you might choose Proposal Quote.

Link Spec Specifies the data to insert in your report. In the previous 
quote example, the Link Spec is Opportunity, Id/Quote, 
Opportunity Id. The syntax of the Link Spec is:

<Parent Business Component Name><Comma><Parent-
ID Field Name><Slash><Child Business Component 
Name><Comma><Child-ID Field Name> 

Descriptions of these fields can be found in Siebel Tools 
Online Help. The Child-ID-Field-Name may vary, depending 
on whether the relationship between your parent business 
component and child business component is one-to-many or 
many-to-many. You or your system administrator can find 
Link Spec information in the Siebel Repository.

You can include only Actuate reports.

Search Spec The search criteria. For example, if you want to insert only 
the Active Quotes for the Opportunity, your Search Spec is 
Active = �Y�.

Table 5. Selected Fields in the Proposal Template Administration View

Section Type Field Comments
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Adding Subsections to Proposal Templates
After adding top-level sections, you may want to add subsections to one or more of them. 

Table Business Object This is the Siebel object from which the information is taken. 
Select from the Business Objects dialog box, which contains 
all available business objects from your repository. For 
example, if you want to include a list of products being 
offered to the opportunity, the business object is 
Opportunity.

Chart or Table 
Name

This is the name of the applet where the table data is stored.

In the example used for Business Object, the applet is 
Opportunity Product Applet.

Width Width represents a percentage of the space available 
between the template margins. If you choose 100, that 
equates to 100% of the space between the template 
margins. If you enter 125, that represents 125% of the 
space between the borders.

If left blank, the width of the columns in the table is based 
on pixels.

Table Fields Click the select button to open the Table Fields dialog box; 
then, for each field you want in the table, add a new record 
and enter the following information:

■ The Field Name of the field; for example, Product.

■ The Sequence in which you want the field listed.

■ The Width of the column in the table; column Width is 
measure in pixels. The default (and minimum) column 
width is 100 pixels. A second way to define column width 
is by percentage of the table width. When a value is 
entered into table width, column width equates to 
percentage of total table width. For example, if there are 
three fields and table width is set to 100, field widths of 
25, 65, and 35 would equate to 25%, 65%, and 35% of 
the total width of the table. In this example, if the table 
width was not set, the field widths would equate to 25, 
65, and 35 pixels.

■ The Alignment of the data in the field: Left, Center, 
Right.

Table 5. Selected Fields in the Proposal Template Administration View

Section Type Field Comments
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To add subsections to an existing section

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template to 
which you want to add a subsection.

The Sections folder appears in the list.

3 In the Template Explorer, click the plus sign (+) next to the Sections folder for this template. 

The Explorer list shows the sections for this template, and the Sections list appears to the right. 

4 In the Template Explorer, click the plus sign (+) next to the section to which you want to add a 
subsection.

The Sections, Related Table, and Components folders for this section appear in the list.

5 Click the plus sign (+) next to the Sections folder for this section. 

The Sections list appears, listing all subsections under this section.

6 Use the Sections list to add a subsection in the same way you used it to add a top-level section, 
as described in �To create top-level sections� on page 40.

NOTE: When a proposal is generated, a section is generated before any of its subsections and is 
displayed above a subsection in the finished document.

Adding Related Table Subsections to Proposal Templates
After adding a Table Name section, you can add related tables that provide detailed information for 
the first table. For example, if the tables subsection contains a quote record, the related table can 
contain the quote line items. The relationship between the information is essentially a parent-child-
grandchild relationship; the opportunity is the parent record, the quote table is the child, and the 
related table containing the quote line items is the grandchild.

To add a related table

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Template Explorer list in the left frame, click the plus sign (+) next to the template to 
which you want to add a related table.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, add a new section or edit an existing section.

5 In the Section Type field, select Table and enter the table name.

6 Complete all necessary fields.
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7 In the Explorer list, click the plus sign (+) next to the Related Table folder.

NOTE: The Related Table folder in the Template Explorer is used only for the Table section type. 
This folder can be edited only if a table has already been added.

8 In the Related Tables dialog box, complete the fields as described in the following table.

Adding Components to Proposal 
Template Sections
Now that you have defined the structure of your document, you must specify the location of the 
component documents that will probably make up the bulk of your proposal.

For sections that draw on data from a Siebel database (such as Chart and Report), you have specified 
all the information necessary for Siebel Proposals to generate the appropriate contents. However, 
the component documents, which you created earlier in Word, are not part of the proposal until you 
add them to the appropriate sections.

NOTE: Components can be added to any kind of section (not just a File section), and a section can 
contain multiple components.

This task is a step in �Process of Creating Proposal Templates� on page 32. 

To add a component to a proposal template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates Explorer, in the left frame, click the plus sign (+) next to the template to which 
you want to add a component.

3 Click the plus sign (+) next to the Sections folder.

4 Click the plus sign (+) next to the particular section that will include a component.

The Sections, Related Table, and Components folders appear.

5 Click the plus sign (+) next to the Components folder.

The Components list appears on the right.

6 In the Components list, create a new record.

Field Comments

Business Object Select the Siebel object to which this table is related. 

Table Name Select the name of the related table applet.

Field Name Select the fields to be displayed in this table. If none are 
selected, all fields appear. The width is interpreted the 
same way as the parent table section. If the width of the 
table section is set, the width of the fields is used as 
percentages instead of pixels.
Siebel Correspondence, Proposals, and Presentations Guide Version 7.846 



Proposals ■  Using Conditions in Proposal Templates
7 In the Add Sales Tools dialog box, select the component you want to add and click Add.

8 If your component does not appear in the list, click New and complete the fields as described in 
the following table.

Using Conditions in Proposal Templates
You can add query conditions to a section or a component to specify the conditions under which the 
section or component will be used in the proposal. For example, if you have two executive 
summaries�one for deals of over $100,000 and another for smaller deals�you can use the Condition 
field in each Executive Summary section to allow Siebel Proposals to insert the appropriate executive 
summary based on the condition that is true.

These tasks are a step in �Process of Creating Proposal Templates� on page 32. 

Entering Criteria
You can enter query criteria in a section or component record�s Condition field (such as [Revenue] > 
100000). If the condition is TRUE, the section or component is included. If the condition is FALSE, 
the section or component is not included. 

If you do not specify a condition, the section or component is always used. 

You can create conditions for any field that is related to the business object of your proposal; use 
Opportunity fields for opportunity proposals, and Account fields for account proposals. If the 
definition of a condition needs to be based on fields from another business object, you must add 
those fields to the Opportunity, Account, Order, or Quote business object through either a link or a 
join. 

The syntax for conditions is similar to the syntax for Siebel queries. 

For more information about the syntax of Siebel queries, see Fundamentals and Siebel Developer�s 
Reference. 

Examples of Criteria
The following examples illustrate the syntax for conditions:

Field Comments

Name Enter a name for the component. 

File Name This field was filled in automatically when you selected a 
file from the Add Sales Tool dialog box.

Sequence Specify the order in which this component should appear in 
the section.

Condition Enter a condition and this component will be displayed only 
when the condition is true.
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■ If the opportunity is for a Pentium computer, you want to insert a component about the 
advantages of the new Pentium II chip. In the Condition field for this component, type the 
following condition:

EXISTS [Product] LIKE "Pentium*"

This condition would look at the products listed for the opportunity. If the product name began 
with Pentium, Siebel Proposals would insert the component. Otherwise, Siebel Proposals would 
leave out this component.

NOTE: For you to use a product in a condition, the product must have been entered using the 
Products view of the Opportunities screen. The condition will not work with products that were 
entered as Quote line items. 

■ If the account is located in Georgia, you should enter a section with terms and conditions limited 
to that state. In the section�s Condition field, you enter the following:

EXISTS ([State] = "GA") 

or 

[State] = "GA"

You use the first line if the account is located only in Georgia, and the second line if the account 
is located in Georgia and another location.

This condition will look at the state for the account. If the state is Georgia, then the section is 
included in the proposal. Otherwise, Siebel Proposals skips this section and moves on to the next.

■ If the opportunity has a revenue amount greater than $1,000,000 and it is expected to close this 
year, you should insert a component on a special program for this type of customer. Enter the 
following condition in the Condition field for the component:

[Revenue] > 1000000 AND [Close Date] <= ("12/31/2003") AND [Close Date] >= ("1/1/
2003")

After you enter a condition, test it as a query in the view you are going to use it in. For example, 
the above example involving Revenue and Close Date can be tested as a query in the My 
Opportunities view. If the query returns the data you expect, the query is probably in the correct 
format for your Condition field.

Defining Proposal Field Mappings
When you created the component documents of your proposal, you probably included bookmarks for 
personalized fields. You must map the bookmarks in the template�s components to Siebel fields.

This mapping tells Siebel Proposals which Siebel field to use for substituting data for a particular 
bookmark in your proposal template. For example, by mapping the bookmark Company to the 
Account field, you tell Siebel Proposals to replace each Company bookmark with the value of the 
Account field.

You cannot map fields to a bookmark in the template�s header or footer unless that bookmark is also 
somewhere else in the content of the template, other than in the footer or header. 
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Because you may be working with multiple proposal templates, you can have multiple sets of 
bookmarks. Therefore, you might have one mapping for one proposal template and another mapping 
for another proposal. Or you might use a single mapping for several proposal templates. In either 
case, you must specify a mapping name in your template record to associate the template with a 
specific mapping.

If you map a bookmark to a multi-value field, the primary record of the group is retrieved. If you 
want to retrieve multiple values from a multi-value field, you can add a Table section to the proposal 
template. This section type will retrieve multiple values from the multi-value field in table format. 

To map the bookmarks in a template�s components to fields, you must perform the following tasks:

■ Create a mapping.

■ Associate a template with the mapping.

These tasks are a step in �Process of Creating Proposal Templates� on page 32. 

NOTE: You may want to base your mappings on the sample mappings that come with Siebel 
Proposals, which are described in �Sample Field Mappings� on page 62. 

Creating a Mapping
To create a field mapping, first create a record for the mapping, and then map the fields.

NOTE: For Siebel Tools objects to be accessible in the Siebel application, the Siebel repository must 
be updated in the appropriate database.

To create a record for a mapping

1 Navigate to the Administration - Document screen > Proposal Field Mappings view. 

2 In the Business Objects list, create a new record and complete the necessary fields.

Some fields are described in the following table.

3 In the Business Objects Explorer, click the plus sign (+) next to the business object for which you 
just created a mapping.

The Business Components folder for this business object appears.

4 Click the plus sign (+) next to this Business Components folder.

The Business Components list for this business object appears. 

Field Comments

Mapping Name Enter a name for the mapping. 

Business Object Select the business object that contains fields used in the proposal. For 
example, if you are creating an opportunity proposal, select Opportunity 
from the Business Objects dialog box.

Description Enter a description of the mapping for your own use. 
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5 In the Business Component list, create a new record and complete the necessary fields.

Some fields are described in the following table.

NOTE: You can associate more than one business component mapping to an object. For example, if 
you are creating an Opportunity proposal, you select the Opportunity business component. You can 
also select the TAS Account business component to create mappings for views under the Opportunity 
TAS view.

Mapping the Fields
Now that you have created a record for the mapping, the next step is to map the fields.

To map the fields 

1 Navigate to the Business Component that contains the fields to be mapped.

2 Click the plus sign (+) next to the Business Component name.

The Business Component Fields folder appears.

3 Click the plus sign (+) next to the Business Component Fields folder.

The Business Component Fields list appears.

4 In the Business Component Fields list, create a new record and complete the necessary fields.

Some fields are described in the following table.

5 Repeat Step 4 for each field that needs to be mapped.

For samples, see �Sample Field Mappings� on page 62.

Field Comments

Business Component The business components must be related to the 
business object. 

Search Specification The search specification limits the records returned 
from the business component. If the search 
specification is not entered, all records from the 
business component will be returned.

Field Comments

Bookmark The bookmark you have added to the Word document.

Business Component 
Field

The fields contained in the business component.
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Associating a Mapping with a Proposal 
Template
After you have created a mapping, you must associate it with a template to make it apply to all the 
components in that template. You can associate a mapping with one or more templates. 

This task is a step in �Process of Creating Proposal Templates� on page 32. 

To associate a mapping with a template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates list, select the record for the template with which you want to associate the 
mapping.

3 In the Mapping Name field, select the mapping you created earlier.

Creating the Proposal Library
As a proposal administrator, you create and maintain the Proposal Library, which consists of pieces 
of text that sales representatives can add to their proposals. In the Siebel File System, these pieces 
of text are components of the File section type.

Documents in the Proposal Library are different from the other components you created earlier, 
because components are parts of the proposal template, which are automatically included in 
proposals generated from that template. Documents in the Proposal Library are available to sales 
representatives only on an as-needed basis. As an administrator, you can also recommend 
documents to include in the templates. 

After sales representatives create a default proposal automatically, they can add more documents 
from the Proposal Library or use the Edit Layout command to customize the default proposal. The 
Proposal Library allows multiple proposals created from the same template to have different 
contents, and it can help sales representatives find answers to specific Request for Proposal (RFP) 
questions.

As an administrator, you place the various components in the Library and maintain the information. 
When the sales representatives need additional text to add to a proposal, they review the documents 
in the Library, select the component they want to insert, and automatically insert it into the proposal. 

The sales force cannot update the information in the Library. The only sections and components 
available to sales representatives are those you provide for them.

To prepare the Proposal Library, you must:

■ Create document files for the Proposal Library.

■ Add sections for the Proposal Library.

■ Add components to the Proposal Library sections.

■ Recommend documents to be included in templates.

These tasks are a step in �Process of Creating Proposal Templates� on page 32. 
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Creating Document Files
You create document files for the Proposal Library in the same way that you create the proposal 
templates themselves. Use Microsoft Word to enter text and bookmarks, and then map these 
bookmarks to fields in your Siebel database. 

NOTE: The only type of section that can be included in the Proposal Library is of the File section type. 
Other section types (Charts, Reports, and so on) can be included only in the template as described 
in �Defining Proposal Template Sections� on page 40.

Adding Sections to the Proposal Library
Sections are used to organize documents in the Proposal Library. For example, if some of the 
documents in the Proposal Library are white papers and others are specifications, you may want to 
create a section for each of these. Then the users will be able to browse through the white papers 
and through the specifications separately. You must add at least one section to the Proposal Library. 
For more information about adding sections, see �Defining Proposal Template Sections� on page 40.

To add sections to the Proposal Library

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 In the Library Explorer, in the left frame, click the plus sign (+) next to the Library folder, if that 
folder is not already open.

3 Click the plus sign (+) next to the Proposal Library.

The Sections folder appears under it.

4 Click the plus sign (+) next to the Sections folder.

5 Add sections to this folder just as you added sections for the proposal.

Adding Components to the Proposal Library
After adding sections to the Proposal Library, you add components to them. 

To add components to the Proposal Library

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add a component.

3 Add the component to the library just as you would add a component to a proposal.

Recommending Content for a Proposal
As the administrator, you can simplify the process of creating a quick proposal by associating 
recommended content with the proposal template.
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To associate recommended content with a proposal

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 Use the Library Explorer to navigate to the section to which you want to associate recommended 
content.

3 Open the selected section folder.

4 Click the plus sign (+) next to the Components folder. 

5 Select a component.

6 In the Components record, click the Recommended Templates field.

7 Add a Recommended Template to the Component record. You can recommend a component to 
one template or to many templates. For example, a legal clause might be required in all 
templates.

8 Repeat Step 5, Step 6, and Step 7 for each component that needs recommended content.

NOTE: Recommended contents are displayed when a proposal is edited using the Edit Layout 
command and the Show Recommended Only check box is selected.

Allowing Users to Display Proposals in 
HTML Format
By default, proposals are saved only in document format, not in HTML format. The user�s View HTML 
button is unavailable, and the user cannot view the proposals in HTML format. 

To allow the user display proposals in HTML format, you must edit the parameter 
DocumentServerViewHTML to give it the value True instead of False. 

NOTE: Users of the Remote Client cannot view proposals in HTML format. 

To allow users to display proposals in HTML format

1 Start the Server Manager.

2 Enter the command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed in the 
Administration - Server Configuration screen. For more information, see Siebel System 
Administration Guide.
Siebel Correspondence, Proposals, and Presentations Guide Version 7.8 53



Proposals ■  Scenario for Generating Proposals (End User)
Scenario for Generating Proposals (End 
User)
This scenario provides an example of the business process performed by a sales representative 
creating proposals for accounts. Your company may follow a different process according to its 
business requirements.

A software company receives a Request for Proposal (RFP) from a prospect interested in outsourcing 
part of the information technology department. The sales representative assigned to the RFP selects 
the opportunity in Siebel Sales, and then creates a new proposal record based on the organization�s 
standard template for proposals. 

The sales representative composes a draft of a proposal that meets the requirements of the RFP, 
adding sections such as a cover letter, executive summary, the proposal body, and sections that 
outline the company�s experience, and references. After conferring with sales team members, the 
sales representative modifies the proposal, changing the order of some of the sections, and adding 
other sections from the Proposal Library.

Process of Generating Proposals (End 
User)
Using proposal templates created by the proposal administrator, sales representatives can create, 
modify and print proposals for an opportunity, using the Opportunities screen > Proposals view.

A proposal is an offer to sell products or services with specific terms and conditions. A proposal can 
be long or short, simple or complex. Even a simple proposal consists of several sections such as a 
cover letter, an executive summary, and a price quotation.

A proposal takes the details you have recorded about an account or opportunity and combines them 
with a predefined template to create a document tailored to the customer�s needs. The template 
defines the initial formatting and structure of your proposal and can include predefined components, 
such as text, tables, and diagrams. It can also be set up to include files from the Proposal Library, 
such as product descriptions and standard terms and conditions. After generating a proposal, you 
can modify it to meet your customer�s requirements.

To generate proposals, perform the following tasks:

■ �Creating a Proposal (End User)� on page 55 (Required)

■ �Generating a Proposal Draft (End User)� on page 55 (Required)

■ �Modifying and Adding Content to a Proposal (End User)� on page 56 (Optional)

■ �Printing a Proposal (End User)� on page 60 (Optional)

■ �Locking a Proposal (End User)� on page 61 (Optional)
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Creating a Proposal (End User)
Before end users can generate a draft of the proposal, they must create a proposal and associate the 
proposal with an opportunity or account. The following procedure explains how to create a proposal 
using the Opportunities screen as an example. The Accounts screen could be used as well.

This task is a step in �Process of Generating Proposals (End User)� on page 54.

To create a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, click Auto Proposal.

Auto Proposal automatically generates a proposal based on a default template or Decision Issue 
associated with the opportunity.

NOTE: To generate a proposal based on a different template, in the proposal record select a different 
template from the Template drop-down list.

Generating a Proposal Draft (End User)
After creating a proposal, end users can generate a proposal draft. The draft is a standard word 
processing document that can be edited if Microsoft Word is installed on the end user�s computer.

End users creating a proposal in a Siebel Web Client environment (network connection) should follow 
Step 1 through Step 4.

End users creating a proposal in a Mobile Web Client environment (remote) who have the Mobile Web 
Client installed locally should follow Step 1 through Step 3.

This task is a step in �Process of Generating Proposals (End User)� on page 54.

To generate a proposal draft

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Generate 
Draft.

In Queue appears in the Status field. 

A draft of the proposal is created if you are in Mobile Web Client environment (remote).

4 Click Update to generate a proposal from the server if you are working in a Siebel Web Client 
network environment.

The status of the proposal refreshes when you click Update. Status values include In Progress, 
Generating, Completed, and Failed.
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Modifying and Adding Content to a 
Proposal (End User)
After creating and viewing a draft of a proposal, end users may decide to change the order of the 
sections, or add new sections.

The following tasks describe how to view, modify, and add content to the proposal:

■ �Viewing the Structure of a Proposal� on page 56

■ �Adding Content to the Proposal� on page 56

■ �Changing the Order of Sections in a Proposal� on page 57

■ �Adding Components to a Proposal� on page 58

■ �Modifying a Proposal Component� on page 60

These tasks are a step in �Process of Generating Proposals (End User)� on page 54.

Viewing the Structure of a Proposal
End users can view the structure of a proposal in the Proposal Table of Contents view, which allows 
viewing of the hierarchy of sections and components that make up a proposal when it is generated. 

Sections are the headings that appear in the proposal. Sections can contain subsections and 
components. Components consist of the actual written information that appears in the proposal. A 
component can contain multiple files. 

To view the structure of a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and drill down on 
hyperlink in the Name field.

The Proposal Table of Contents appears, showing the structure of the proposal. 

4 In the explorer pane, click the plus sign (+) next to each section to expand sections and 
components.

Adding Content to the Proposal
If an administrator has created optional sections in the Proposals Library, end users can customize 
the proposal by adding one or more of these sections. The Edit Layout command allows end users to 
add content to a proposal using the Proposal Library.
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To add content from the Proposal Library

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Edit Layout.

4 In the Template Layout dialog box, to display more items in the Content Library list, clear the 
Show Recommended Only check box. 

NOTE: If the Show Recommended Only check box is selected, only those component templates 
recommended by the administrator are displayed. If this check box is cleared, all available 
components are displayed. For more information, see �Sample Proposal Data: Field Mappings and 
Templates� on page 61.

5 In the Template Layout dialog box, move items from the Content Library pane to the Table of 
Contents pane, and then click Save.

6 In the Proposals list, drill down on the proposal name to open the Proposal Table of Contents view 
to see the new content.

Changing the Order of Sections in a Proposal
When end users add a section to a proposal, the sequence numbers are not automatically 
regenerated. If a section is inserted within the current sequence, each sequence number must be 
modified. The sequence numbers in the Proposals list determine the order in which sections and 
components appear. There are two methods that can be used to resequence proposal sections and 
components:

■ Edit Layout.

■ Proposal Table of Contents.

To use Edit Layout

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Edit Layout.

4 In the Template Layout dialog box, use the sequencing arrows to change the order of the 
sections.

NOTE: The Show Recommended Only check box is automatically selected in the Template Layout 
dialog box only if there are recommended components in the list. Otherwise, the check box is 
cleared.

To use Proposal Table of Contents

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.
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3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand each section.

5 In the Sections list, change the number in the Sequence field for each selected section.

To remove sections in a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand each section.

5 In the Sections list, select the section and click Delete.

NOTE: You can also use the Edit Layout command to remove content from a proposal. For more 
information, see �To use Edit Layout� on page 57.

Adding Components to a Proposal
Section components are the boilerplate text that make up a proposal. To add components, 
components must already be associated with the section. End users can add components to sections 
from the Proposals Library, from the Siebel Encyclopedia, or from another location, such as a local 
hard drive. More than one component can be added to a section.

The Proposal Library offers a hierarchy structure that administrators can use when designing 
literature components that can be associated with a proposal. Using the Proposal Library, end users 
can navigate to a section or subsection, and then select the component file associated with the 
section. 

To add a component to a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposals Table of Contents explorer, click the plus sign (+) next to show the hierarchy of 
the proposal you want to change.

The Sections folder appears.

5 Click the plus sign (+) to expand the Sections folder.

Each section associated with the proposal appears in the Sections list. 

6 Click the plus sign (+) to expand the section that will contain the new component.
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7 In the Sections list, click Library.

The Proposals Library view appears.

8 In the Proposals Library Explorer, click the plus sign (+) for Proposals Library. 

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where the proposal is located.

The list of components for that section appears. 

9 In the Components list, click the plus sign (+) next to the Components folder, select the 
component in the list, and then click Add Components.

The component file is added to the Components folder located in the section you selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand the proposal 
contents.

a Click the plus sign (+) next to the Sections folder to expand the folder.

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

The Add Sales Tools dialog box appears.

6 In the Add Sales Tools dialog box, select each record you want to add, and then click Add.

NOTE: Only DOC and TXT files can be added as components directly into a template section.

To add a component from another location

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) next to the proposal to expand 
the proposal.

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where you want to add a new file.
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c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

6 In the Add Sales Tools dialog box, click New. 

7 In the Components form, enter a name and sequence for the file, and then click the select button 
in the File Name field to attach the file.

8 Attach the file using the Add Attachment dialog box.

Modifying a Proposal Component
End users can modify a component file if they have Microsoft Word for Proposals installed locally on 
their computer. End users must have the same application that was used to create the component. 

To modify a component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) next to the proposal. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, select the component, and then drill down on the File Name hyperlink.

6 In the File Download dialog box, click Open to begin editing the file. Make any necessary edits 
and do one of the following:

a Click Save to save the file. If the Local check box is selected for this component, the file will be 
updated in the Siebel application.

b Click Save As to save the file to your local hard drive and then:

❏ In the Components list, select the component (saved locally), click Edit, and locate the 
modified component.

❏ Select the modified component, and then add it.

The old component is replaced with the new one.

Printing a Proposal (End User)
After generating a proposal, and the status is Completed, end users can print the proposal to send 
to the prospective customer.
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This task is a step in �Process of Generating Proposals (End User)� on page 54.

To print a proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the proposal you want to print.

2 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Draft 
Name field of the proposal you want to print.

The proposal opens in Microsoft Word.

3 Print the proposal using Microsoft Word.

Locking a Proposal (End User)
Lock allows end users to secure the completed proposal, making the proposal read-only and unable 
to be edited. Only the proposal author, the author�s manager, and that manager�s manager, and so 
on, can modify or unlock the proposal.

This task is a step in �Process of Generating Proposals (End User)� on page 54.

To lock the proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal.

4 In the proposal record, select the check box in the Locked field.

NOTE: If the Locked check box does not appear, click the menu button in the Proposals list, and then 
choose Columns Displayed.

Sample Proposal Data: Field Mappings 
and Templates
To help you create your first proposal, your Siebel application includes sample data. 
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Sample Field Mappings
The Administration - Document screen > Proposal Field Mappings view includes two mappings: 
Opportunity and Account. These mappings list common fields you can use in creating your proposal. 
Table 6 and Table 7 show these mappings.

Use the Bookmark name in your Word document when you create a bookmark (for example, REF 
Company) and select this mapping for the Proposal Templates you create. It will match to the Siebel 
Business Component field (for example, Account) in your proposal draft with that assigned mapping.

Sample Templates
Siebel Business Applications come with a sample database. Both the Opportunities screen > 
Proposals view and the Accounts screen > Proposals view include several sample proposal templates 
for Microsoft Word. 

Table 6. For Business Object: Opportunity, Business Component: Opportunity

Bookmark Business Component Field

Company Account

Address Street Address

City City

State State

ZipCode Postal Code

Country Country

Industry Industry

Table 7. For Business Object: Account, Business Component: Account

Bookmark Business Component Field

Company Account

Address Street Address

City City

State State

ZipCode Postal Code

Country Country

Industry Industry

Account Type Type
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These sample proposals can be used as a reference when you define your own proposal template. In 
this sample database, you will find the following Siebel Proposals sample proposals: 

■ Standard

■ Standard Account

■ Strategic

■ Quality Strategic Account

The sample templates fall into the following categories: 

■ Standard: Oppty Ppsl

■ Standard Account: Acct Ppsl

■ Strategic: Oppty Ppsl

■ Opportunity Account Plan: Oppty Ppsl

■ Quality Strategic Account: Acct Ppsl

Seed Templates
Customers using the Target Account Selling Module (TAS) can run an Opportunity Plan report in 
Microsoft Word using the TAS Opportunity Plan template. This proposal template is available in the 
seed database. For more information on setting up the TAS Opportunity Plan template, see the 
Upgrade Guide for the operating system you are using.
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5 Presentations
This chapter is about administering and using Siebel Presentations. It includes the following topics:

■ �About Siebel Presentations� on page 65

■ �Process of Creating Presentation Templates� on page 66

■ �About Generating Presentations (End User)� on page 84

■ �Scenario for Generating Presentations (End User)� on page 84

■ �Process of Generating Presentations (End User)� on page 85

■ �Sample Presentation Templates� on page 92

For information about the Documentation Server and other software that is required for Siebel 
Presentations, see Chapter 2, �Document Server.� 

About Siebel Presentations
Siebel Presentations allows your sales representatives to create presentations (and other types of 
documents) based on templates that you create in Microsoft PowerPoint.

Traditionally, salespeople create presentations by starting with a presentation that worked in the past 
and then modifying it for the current prospect. Salespeople must not only change such basic 
information as the customer�s name, but also possibly restructure the presentation so that it fits this 
new prospect�s unique needs. For example, the original presentation may have been focused on 
price, whereas the new prospect is more concerned with other decision criteria, such as speed or 
extra functionality. 

With Siebel Presentations, once the presentation administrator has created the right templates, the 
salesperson can click one button to build the correct presentation for a specific account or 
opportunity. Siebel Presentations uses information that salespersons have entered in the early 
stages of an opportunity to create the presentation. 

Salespeople can add deal-specific information to the presentation without worrying about formatting 
or presentation. Using the Presentation Library, salespeople can find any additional information and 
automatically insert it into the presentation. 

System Requirements for Siebel 
Presentations
Certain system requirements must be met to use Siebel Presentations.
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System Requirements for the Siebel Web Client
To use Siebel Presentations, you must have:

■ All of the components that are required to use the Siebel application installed on the server, such 
as a Siebel Server and a Web Server. 

■ The Document Server installed on one or more Windows machines.

■ Microsoft Office.

NOTE: If you are deploying the Siebel Server in UNIX and want to use Presentations, a separate 
Windows machine is required for the Document Server.

Siebel Presentations uses the Document Server, which is a component of the Siebel Server which lets 
users on the Web work with Word, and PowerPoint documents on the server. 

For more information on installing the components required to use the Siebel application, see Siebel 
Installation Guide for the operating system you are using.

Your employees or partners who use Siebel Presentations need:

■ A Web browser to use the product. 

■ Optionally, Microsoft Office to edit documents.

For information on the Web browsers that are supported by Siebel applications, see System 
Requirements and Supported Platforms on Siebel SupportWeb.

System Requirements for the Siebel Remote Web Client
Siebel Presentations is available for the Siebel Remote Web Client as well as for the Siebel Web 
Client. The user interface for Presentations is identical in the Siebel Remote Web Client and the Siebel 
Web Client. 

Siebel Remote Web Client processes requests to generate documents locally, so field sales 
representatives can generate correspondences, proposals, and presentations when they are out of 
the office. To run Siebel Presentations on the Siebel Remote Web Client, you must have Microsoft 
Office installed on the same machine as the Siebel Remote Web Client. 

Process of Creating Presentation 
Templates
To create presentation templates, perform the following tasks:

■ �Creating Template Slides in Microsoft PowerPoint� on page 67. To create the slides needed by the 
template, you must write their content and insert bookmarks for such variables as company, 
contact name, address.

■ �Creating a Record for the Presentation Template� on page 70. Use your Siebel application to create 
a single record for the template.

■ �Defining Presentation Template Sections� on page 71. Specify which sections the presentation 
should contain.
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■ �Adding Components to Presentation Template Sections� on page 77. Specify which components 
each section should contain.

■ �Using Conditions in Presentation Templates� on page 78. Optionally, you can add conditions to 
specify that sections or components are included in the presentation only under certain 
circumstances.

■ �Defining Presentation Field Mappings� on page 79. Specify which Siebel objects correspond to 
each bookmark in your PowerPoint component slides. You also specify the name of this mapping 
in the template record.

■ �Creating the Presentation Library� on page 81. In this optional step, which can be done at any 
time, you create a separate library of slides that salespeople can draw upon to customize their 
presentations.

■ �Allowing Users to Display Presentations in HTML Format� on page 84. Update settings on the 
document server to allow end users to view presentations in HTML.

Creating Template Slides in Microsoft 
PowerPoint
The first step is to create slides in Microsoft PowerPoint. These slides consist of one style slide and 
multiple component slides, as shown in Figure 3.

Figure 3. PowerPoint Slides That Can Make Up a Presentation Template
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The components shown in Figure 3 on page 67 are only examples. You could have other components, 
such as a table of contents or a set of collateral, and you could omit the quotes or product 
descriptions. However, a template must have a presentation background slide and one or more 
component slides.

NOTE: See Release Notes on Siebel SupportWeb for information about which versions of Microsoft 
PowerPoint are supported.

NOTE: Presentations can only use fields from one business object. If you want to include additional 
fields, you must use Siebel Tools to add the business components that include these fields to the 
business object that is the basis of the presentation. 

To create the template slides, you go through the following stages:

■ Planning the template. Decide what components the template should have.

■ Creating the style slide. Create the slide that gives all the template components a standard 
formatting. 

■ Creating the component slides. Create a slide for each component of the template. 

These tasks are a step in �Process of Creating Presentation Templates� on page 66.

Planning the Presentation Template
Before you create the slides in PowerPoint, you must determine how the presentation should look 
and what type of information it should contain. Begin by looking at previous successful presentations 
to see what sections they contained. For example, did they all contain an agenda, an executive 
overview slide, and a product summary slide? Next, look to see what current slides you have on 
hand, and what customer questions these pieces answer. Then decide how to organize your 
information. What topics could be standard across all presentations? What topics are specific to 
certain presentations? What is the best order for the pieces in the presentation you are creating? 
Finally, decide what fields to insert to customize their presentations (for example, contact name, 
account name, industry). You will use this information to create bookmarks in your PowerPoint slides.

Creating a Presentation Background Slide
After you plan your templates, work on the presentation background slide for this template, which 
is the slide that serves as your title slide and also specifies the background layout and formatting of 
the entire presentation. This background slide may contain your company logo, special colors and 
background designs, and headers and footers. 

NOTE: The following procedure may vary slightly, depending on your version of Microsoft 
PowerPoint.

To set up styles for your presentation template

1 Create a new slide in Microsoft PowerPoint. 

2 Since this slide will also serve as your title slide, you may want to select the title slide layout 
template and enter the title of the presentation.

3 Select the background colors and font size.
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4 Choose View > Header and Footer, and create and apply a header and a footer for your template.

5 Switch to the Master Slide view, and select formatting options that will apply to your whole 
presentation.

6 Close the Master Slide view, and return to the Slide view (choose View > Slide).

7 Save the file:

■ Choose a name that uses only alphanumeric characters. 

■ Use the .ppt extension for PowerPoint.

8 Close the file.

Creating Presentation Template Components
The next step in developing your template is to create components, the slides that make up the body 
of your presentation. 

A component is the Siebel Presentations term for a Microsoft PowerPoint presentation that includes 
standard text and personalized data. 

To create a component, you type the standard text and then create bookmarks, or Microsoft 
PowerPoint placeholders for custom data. When a salesperson generates a presentation, these 
bookmarks will be replaced with data from the Siebel application. 

NOTE: The following procedure may vary slightly, depending on your version of Microsoft 
PowerPoint.

To create a component with bookmarks

1 Create a new slide in Microsoft PowerPoint.

2 Type the standard text, pictures, bulleted information, and so on that belongs in this component.

3 Place the cursor where you want to create a bookmark.

4 Enter the following text:

[[�name of bookmark�]] 

For example, to create a bookmark for the company name, type:

[[Company]] 

5 Write down the name of the bookmark, because you will need it later when you map the 
bookmark to a Siebel field name. 

6 Repeat Step 3 through Step 5 for every bookmark you want to insert. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

7 Save the component slide as a PPT file.
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Creating a Record for the Presentation 
Template
After you have created your template slides in PowerPoint, you can use Siebel Presentations to 
specify how they are assembled in the template. 

This task is a step in �Process of Creating Presentation Templates� on page 66.

To create a record for the presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name Enter a name for the template. 

Default If you want this template to be the default presentation template, place a check 
mark in the Default field. When the user clicks Auto Presentation, Siebel 
Presentations uses the default template if there are no decision issues that 
match the theme of a presentation. You can only select one Opportunity 
Presentation default and one Account Presentation default.

Category Select one of the following types of templates:

■ Opportunity Presentation. These templates are available only when you 
are working with Opportunities. 

■ Account Presentation. These templates are available only when you are 
working with Accounts.

Mapping 
Name

Used to indicate the group of bookmark fields to be used with this template. 
You can leave this field blank for now, until you create a mapping.

Template 
File Name

Attach the template file.

Theme If you want to associate the template with a particular decision issue, click the 
select button in the Theme field, and select a theme from the Pick Decision 
Issue dialog box. When you give your presentation template a theme, you 
associate it with a particular decision issue that is important for your 
opportunity. When a presentation theme matches the number one decision 
issue for the current opportunity, Siebel Presentations automatically selects the 
correct template when the user clicks Auto Presentation. Users can also select 
a theme template if they want.

Because accounts do not relate to decision issues, the Theme field is not 
applicable for Account Presentation templates. It only applies to Opportunity 
Presentation templates.

Description Enter a description of the template.
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Defining Presentation Template 
Sections
Once you have created your PowerPoint slides and a record for your template, define the structure 
of your presentation template.

A presentation is made up of sections, which divide and subdivide your presentation. Depending on 
your needs, a single section might contain multiple components or a single component.

The type of a section depends on what type of data it contains. For example, file sections contain 
slides, chart sections reference Siebel charts, and so on.

You define the structure of the presentation template by creating sections in the Administration - 
Document screen > Presentation Templates view, which are associated with the Template record you 
created for this template. 

These tasks are a step in �Process of Creating Presentation Templates� on page 66.

Creating Top-Level Sections for the Presentation Template
First you must create top-level sections, then you can add subsections to these top-level sections. 
Your presentation structure can have multiple levels of sections, since a subsection can contain other 
subsections.

To create top-level sections

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer, in the left frame, click the plus sign (+) next to the icon representing 
this template.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder. 

The Sections list appears in the right frame.

4 In the Sections list, create a new record. 

5 In the Name field, enter a name for this section.

The section name is the title of the slide for some types, such as Bullet Slide.

6 In the Sequence field, specify the order in which this section should appear in the presentation. 

Language The language in which the template was written.

Locale Only the templates specific to this locale will be shown.

Field Comments
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7 In the Section Type field, indicate the type of section you are creating. The following table 
describes the different section types available to you.

8 Complete the fields applicable to your section type. Table 8 on page 73 describes the fields that 
you should complete for each type of section.

Type Comments

Bullet Slide Creates a slide and inserts a list of Siebel data in bullet format�for example, 
a list of products the opportunity is interested in.

This section name is used as the slide title.

Chart Creates a slide and inserts a Siebel chart. The chart is automatically 
centered, and you can change x, y, and z axes. 

File Contains only presentation slides or text. If you are using PowerPoint, they 
must be in PPT, DOC, or TXT format. If you indicate text, it creates a slide 
and inserts the text.

Locator Pulls in slides or text (PPT slides or TXT files) from the Siebel Encyclopedia. 
If you create a locator section, Siebel Presentations can dynamically pull in 
slides from the marketing encyclopedia that relate to the products the 
opportunity is interested in. For example, if you want the presentation to 
dynamically insert slides related to the products on the opportunity, use a 
Locator.

The file types must be PPT, TXT, or RTF. If more than one marketing slide 
meets the Locator criteria you specify, Siebel Presentations inserts each.

Organization 
Chart

Creates a slide and pulls in Organization charts for the Account or 
Opportunity associated with the template. Charts are automatically 
centered.

Table Creates a slide and pulls Siebel data into a table format. You select fields to 
be included, the sequence of the fields, and the column length. Tables are 
automatically centered. By selecting a Table Section, you also enable 
creation of a Related Table section. See �Adding Related Table Subsections to 
the Presentation Template� on page 76.

Two-Column 
Slide

Creates a slide that puts two sections next to each other. You can, for 
example, show a list of key features of a product (a Bullet Slide section) next 
to a picture of the product (a File section). You specify the two subsections, 
which can be any of the other section types.
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9 Repeat Step 4 on page 71 through Step 8 to add all the top-level sections that are needed.

Table 8. Selected Fields for the Presentation Template Administration View

Section Type Field Comments

Bullet Slide Business Object The Siebel business object from which the information is 
taken. Select from the list, which contains all available 
business objects from your repository, or enter the name in 
the field. For example, to include a Bullet List of products 
offered with the quantity and ship date for the opportunity, 
the business object is Opportunity.

File N/A You do not need to complete any fields for this type of 
section.

Chart Business Object The Siebel business object the chart information is coming 
from (for example, Opportunity). Select from the Business 
Object list, which lists all available business objects from 
your repository.

Chart or Table 
Name

The name of the chart applet you want to insert into this 
section. For example, �Opportunity Chart Applet - Current 
Opportunity Analysis.� The list also contains all available 
applets from your repository.

Search Spec Any search criteria you want to use to restrict data for the 
chart (for example, Revenue > 500000).

Category With charts that contain multiple X-axis options, this field 
allows you to set which option to use for the X-axis. For 
example, in the Lead Analysis by Rep chart, the X-axis can 
be Sales Representative or Quality.

Function With charts that contain multiple Y-axis options, this field 
allows you to set which option to use for the Y-axis. For 
example, in the Lead Analysis by Rep chart, the Y-axis can 
be Number of Opportunities, Opportunity Revenue, or 
Average Opportunity Revenue.

Series This field allows you to set the Z-axis you wish to use for 
charts that contain multiple Z-axis options.
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Locator Information 
Retrieval 
Method

Select which relationship to use to find the literature. For 
example, Oppty Competitor, which are the slides on 
competitors associated with the opportunity.

To associate literature with a product, competitor, or 
partner, use the Literature Administration view (or the 
Decision Issue, Competitor, or Product Administration 
views). See Applications Administration Guide for more 
information.

Retrieved 
Literature 
Category

Indicate what type of literature you are looking for (for 
example, brochures, specification sheets, and so on).

This helps you to filter out the slides from the rest of the 
documents in the marketing encyclopedia, to be included in 
your presentation.

Organization 
Chart

Business Object The Siebel object from which the information is taken. 
Select from the Business Objects dialog box, which contains 
all available business objects from your repository.

Chart or Table 
Name

The name of the applet that contains the organization chart 
data. For example, the Opportunity Organization Analysis 
applet.

Table 8. Selected Fields for the Presentation Template Administration View

Section Type Field Comments
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Adding Subsections to the Presentation Template
After adding top-level sections, you may want to add subsections to one or more of them. 

Table Business Object This is the Siebel business object from which the 
information is taken. Select from the Business Objects 
dialog box, which contains all available business objects 
from your repository. 

For example, if you want to include a table of products being 
offered, with the quantity and ship date for the opportunity, 
the business object is Opportunity.

Chart or Table 
Name

The name of the applet where the table data is stored.

In the example used for Business Object, the applet is 
Opportunity Product Applet.

Table Fields Open the Table Fields dialog box and then, for each field you 
want in the table, click New and enter the following 
information:

■ The Field Name of the field; for example, Product.

■ The Sequence in which you want the field listed.

■ The Width of the column; the default (and minimum) 
width is 100 pixels. A second way to define column width 
is by percentage of the table width. When a value is 
entered into table width, column width equates to 
percentage of total table width. For example, if there are 
three fields and table width is set to 100, field widths of 
25, 65, and 35 would equate to 25%, 65%, and 35% of 
the total width of the table. In this example, if the table 
width was not set, the field widths would equate to 25, 
65, and 35 pixels.

■ The Alignment of the data in the field: Left, Center, or 
Right.

Two-Column Slide N/A Create two subsections under the section you have 
designated as Two-Column Slide. For each subsection, 
complete the fields appropriate to that type of section. For 
example, if you want to show a Chart section next to a Table 
section, create a subsection of the Chart section type (and 
complete the Chart-related fields shown in this table) and 
create a subsection of the Table type (and complete the 
Table-related fields shown in this table).

Table 8. Selected Fields for the Presentation Template Administration View

Section Type Field Comments
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To add subsections to an existing section

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer, in the left frame, click the plus sign (+) next to the template to which 
you want to add a subsection.

The template�s Sections folder appears.

3 In the Template Explorer, click the plus sign (+) next to the Sections folder for this template. 

The Explorer displays the sections for this template, and the Sections list is displayed to the right. 

4 In the Template Explorer, click the plus sign (+) next to the section to which you want to add a 
subsection.

The Sections and Components folders appear for this template.

5 Click the plus sign (+) next to the Sections folder for this section. 

The Sections list appears, listing all subsections under this section.

6 Use the Sections list to add a subsection in the same way you used it to add a top-level section, 
as described in �Creating Top-Level Sections for the Presentation Template� on page 71.

NOTE: When a presentation generates, a section generates before any of its subsections and is 
displayed prior to a subsection in the finished presentation.

Adding Related Table Subsections to the Presentation Template
After adding a Table Name subsection, you can add related tables that provide detailed information 
for the first table. For example, if the tables subsection contains a quote record, the related table 
can contain the quote line items. The relationship between the information is essentially a parent-
child-grandchild relationship; the opportunity is the parent record, the quote table is the child, and 
the related table containing the quote line items is the grandchild.

To add a related table

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template to 
which you want to add a related table.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, add a new section or edit an existing section.

5 In the Section Type field, select Table and enter the Table Name.

6 Complete all necessary fields.
Siebel Correspondence, Proposals, and Presentations Guide Version 7.876 



Presentations ■  Adding Components to Presentation Template Sections
7 In the Explorer list, click the plus sign (+) next to the Related Tables folder.

NOTE: The Related Table folder in the Template Explorer is used only for the Table section type. 
This folder can be edited only if a table is already added.

8 In the Related Tables dialog box, complete the fields as described in the following table.

Adding Components to Presentation 
Template Sections
Now that you have defined the structure of your document, you must specify the location of the 
component slides that will probably make up the bulk of your presentation.

For sections that draw upon data from a Siebel database (such as Chart and Report), you have 
specified all the information necessary for Siebel Presentations to generate the appropriate contents. 
However, the component documents, which you created earlier in PowerPoint, are not part of the 
presentation until you add them to the appropriate sections.

NOTE: Components can be added to any kind of section (not just a File section), and a section can 
contain multiple components.

Components can be PPT or DOC, TXT, or RTF files. When they are not PPT files, Siebel Presentations 
creates a slide (with your template background) and imports the text into the slide. PowerPoint 
inserts the TXT and DOC files based on how you have formatted the documents. For example, 
PowerPoint inserts TXT or DOC paragraphs in the slide as paragraphs, but if your file contains TXT 
or DOC indented or bulleted paragraphs, PowerPoint attempts to create a slide for each bullet point, 
or one slide for all bullet points, depending on the formatting and carriage returns in your document.

To make sure that TXT or DOC files are inserted correctly in your PowerPoint presentation, open the 
text or PowerPoint document itself in PowerPoint and verify that the format is correct. The format 
you see when you open the file in PowerPoint will be the same format Siebel applications use in the 
presentation.

This task is a step in �Process of Creating Presentation Templates� on page 66.

To add a component to a presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates Explorer, in the left frame, select the template to which you want to add a 
component.

The Sections and Components folders appear for the template.

Field Comments

Business Object Select the Siebel object to which this table is related. 

Table Name Select the name of the related table applet.

Field Name Select the fields that will be displayed in this table. If none are selected, 
all fields appear.
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3 Click the plus sign (+) for the Components folder.

The Components list appears on the right.

4 In the Components list, create a new record.

The Add Sales Tools dialog box appears. 

5 In the Add Sales Tools dialog box, perform one of the following actions:

■ Select the component you want to add and click Add.

■ If your component does not appear in the dialog box, click New.

6 Complete the component fields as described in the following table.

Using Conditions in Presentation 
Templates
You can add query conditions to a section or a component to specify the conditions under which the 
section or component will be used in the presentation. For example, if you have two executive 
summaries�one for deals of over $100,000 and another for smaller deals�you can use the condition 
field in each Executive Summary section to allow Siebel Presentations to insert the appropriate 
executive summary based on which condition is true.

These tasks are a step in �Process of Creating Presentation Templates� on page 66.

Entering Criteria
You can enter query criteria in a section or component record�s Condition field (such as [Revenue] > 
100000). If the condition is TRUE, the section or component is included. If the condition is FALSE, 
the section of component is not included. 

If you do not specify a condition, the section or component is always used. 

You can create conditions for any field that relates to the business object of your presentation; use 
Opportunity fields for opportunity presentations, and Account fields for account presentations. If the 
definition of a condition needs to be based on fields from another business object, then you must 
add those fields to the Opportunity or Account business object through either a link or a join. The 
syntax for conditions is similar to the syntax for Siebel queries. For more information about the 
syntax of Siebel queries, see Fundamentals and Siebel Developer�s Reference. 

Field Comments

Name Enter a name for the component. 

Sequence Specify the order in which this component should appear in the section.

Attachment Name This field was filled in automatically when you selected a file from the 
Add Sales Tool dialog box.

Condition Enter a condition and this component will be displayed only when the 
condition is true.
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Examples of Criteria
The following examples illustrate the syntax for conditions:

■ If the opportunity is for a Pentium computer, you want to insert a component about the 
advantages of the Pentium chip. In the Condition field for this component, type the following 
condition:

EXISTS [Product] LIKE "Pentium*"

This condition would look at the products listed for the opportunity. If the product name begins 
with Pentium, Siebel Presentations would insert the component. Otherwise, Siebel Presentations 
would leave out this component.

NOTE: To use a product in a condition, the product must have been entered using the Products 
view of the Opportunities screen. The condition will not work with products that were entered as 
Quote line items. 

■ If the account is located in Georgia, you want to enter a section with terms and conditions limited 
to that state. In the section�s Condition field, you would enter the following:

EXISTS ([State] = "GA") 

or 

[State] = "GA"

You would use the first line if the account is located only in GA, and the second line if the account 
is located in GA and another location.

This condition will look at the state for the account, and if the state is GA then the section would 
be included in the presentation; otherwise, Siebel Presentations would skip this section and move 
on to the next.

■ If the opportunity has a revenue amount greater than $1,000,000 and it is expected to close this 
year, you want to insert a component on a special program for this type of customer. Enter the 
following condition in the Condition field for the component:

[Revenue] > 1000000 AND [Close Date] <= ("12/31/02") AND [Close Date] >= ("1/1/02")

After you enter a condition, test it as a query on the view you are going to use it on. For example, 
the above example involving Revenue and Close Date can be tested as a query on the My 
Opportunities view. If the query returns the data you expect, the query is probably in the correct 
format for your condition field.

Defining Presentation Field Mappings
When you created the component slides of your presentation, you probably included bookmarks for 
personalized fields. You must map the bookmarks in the template�s components to Siebel fields.

This mapping tells Siebel Presentations which Siebel field to use for substituting data for a particular 
bookmark in your presentation template. For example, by mapping the bookmark Company to the 
Account field, you tell Siebel Presentations to replace each Company bookmark with the value of the 
Account field.
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You cannot map fields to a bookmark in the template�s header or footer, unless that bookmark is also 
somewhere else in the content of the template, other than in the footer or header. 

Since you may be working with multiple presentation templates, you can have multiple sets of 
bookmarks. You could have one mapping for one presentation template and another mapping for 
another presentation, or you could use a single mapping for several presentation templates. In either 
case, you must specify a mapping name in your template record to associate the template with a 
specific mapping.

If you map a bookmark to a multi-value field, the primary record of the group is retrieved. If you 
want to retrieve multiple values from a multi-value field, you can add a Table section to the document 
template. This section type will retrieve multiple values from the multi-value field in table format. 

To map the bookmarks in a template�s components to fields, you must: 

■ Create a mapping.

■ Associate a template with the mapping. 

These tasks are a step in �Process of Creating Presentation Templates� on page 66.

Creating a Mapping
To create a field mapping, first create a record for the mapping, and then map the fields.

NOTE: For Siebel Tools objects to be accessible in the Siebel application, the Siebel repository must 
be updated in the appropriate database.

To create a record for a mapping 

1 Navigate to the Administration - Document screen > Presentation Field Mappings view. 

2 In the Business Objects list, create a new record. 

3 Complete the fields as described in the following table.

4 In the Business Objects Explorer, in the left frame, click the plus sign (+) next to the business 
object for which you created a mapping.

5 Select the Business Components folder.

Field Comments

Mapping Name Enter a name for the mapping. 

Business Object Use the Business Objects dialog box to select the business object that 
contains fields used in the presentation, and then click OK. For example, 
if you are creating an opportunity presentation, select Opportunity in the 
Business Object field.

Description Enter a description of the mapping for your own use. 
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6 In the Business Component list, create a new record and complete the fields.

NOTE: You can associate more than one business component mapping with an object. For example, 
if you are creating an opportunity presentation, you would select the Opportunity business 
component. You could also select the TAS Account business component to create mappings for views 
under the Opportunity TAS view.

Mapping the Fields
Now that you have created a record for the mapping, the next step is to map the fields.

To map the fields 

1 Navigate to the business component that contains the fields to be mapped.

2 Click the plus sign (+) next to the Business Component name.

The Business Component Fields folder appears.

3 Click the plus sign (+) next to the Business Component Fields folder.

The Business Component Fields list appears.

4 In the Business Component Fields list, create a new record and complete the necessary fields.

5 Repeat Step 4 for each field that needs to be mapped.

Associating a Mapping with a 
Presentation Template
After you have created a mapping, you must associate it with a template to make it apply to all the 
components in that template. You can associate a mapping with one or more templates. 

To associate a mapping with a presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates list, select the template record with which you want to associate the mapping.

3 In the Mapping Name field, select the mapping you created earlier.

Creating the Presentation Library
As a presentation administrator, you create and maintain the Presentation Library, which consists of 
slides that sales representatives can add to their presentations. 
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Slides in the Presentation Library are different from the other components you created earlier, 
because components are part of the presentation template, which are automatically included in 
presentations generated from that template. Slides in the Presentation Library are available to sales 
representatives only on an as-needed basis. As an administrator, you can also recommend 
documents to include in the templates.

After sales representatives create a default presentation automatically, they can add more slides 
from the Presentation Library or use the Edit Layout command to customize the presentation. The 
Presentation Library allows multiple presentations created from the same template to have different 
contents.

As an administrator, you place the various components in the Presentation Library and maintain the 
information. When the sales representatives need additional slides to add to a presentation, they 
review the Presentation Library, select the component they want to insert, and automatically insert 
it into the presentation. 

The sales force cannot update the information in the Presentation Library. The only sections and 
components available to sales representatives are those you provide for them. 

To prepare the Presentation Library, you must:

■ Create Microsoft PowerPoint files for the Presentation Library.

■ Add sections for the Presentation Library.

■ Add components to the Presentation Library sections.

■ Recommend documents to be included in templates.

These tasks are a step in �Process of Creating Presentation Templates� on page 66.

Creating Presentation Files for the Presentation Library
You create presentation files for the Presentation Library in the same way that you create the 
presentation templates themselves. Use Microsoft PowerPoint to enter text, graphics, and 
bookmarks, and then map these bookmarks to fields in your Siebel database. 

NOTE: The only type of component that can be included in the Presentation Library is the File section 
type. Other section types (Charts, Reports, and so on) can be included only in the initial template.

Adding Sections to the Presentation Library
Sections are used to organize slides in the Presentation Library. For example, if some of the slides 
in the Presentation Library are marketing pieces and others are technical, you may want to create a 
section for each of these. Then the users will be able to browse through the marketing pieces and 
through the technical pieces separately. You must add at least one section to the Presentation 
Library. For more information about creating presentation sections, see �Defining Presentation 
Template Sections� on page 71.

To add sections to the Document Library

1 Navigate to the Administration - Document screen > Presentation Library view. 
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2 In the Library Explorer, in the left frame, click the plus sign (+) of Presentation Library.

The Sections folder appears under the Library.

3 Add the sections to this folder as needed.

Adding Components to the Presentation Library
After adding sections to the presentation library, you add components to them. 

For more information about adding presentation components, see �Adding Components to 
Presentation Template Sections� on page 77.

To add components to the Presentation Library

1 Navigate to the Administration - Document screen > Presentation Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add a component.

3 Add the component to the library just as you would add a component to a presentation.

Recommending Content for a Presentation
As the administrator, you can simplify the process of creating a quick presentation by associating 
recommended content with the presentation template.

To associate recommended content with a presentation

1 Navigate to the Administration - Document screen > Presentation Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add recommended 
content.

3 Open the selected section folder.

4 Click on the plus sign (+) of the Components folder. 

5 Select a component.

6 In the Components record, click in the Recommended Template field.

7 Add a Recommended Template to the Component record. You can recommend a component to 
one template or to many templates. For example, a legal clause might be required in all 
templates.

8 Repeat Step 5, Step 6, and Step 7 for each component that needs recommended content.

NOTE: Recommended templates are displayed when a presentation is edited using the Edit 
Layout command and the Show Recommended Only box is selected.
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Allowing Users to Display Presentations 
in HTML Format
By default, presentations are only saved in document format, and not in HTML format. The user�s 
View HTML button is unavailable, and the user cannot view the presentations in HTML format. 

To allow the user display presentations in HTML format, you must edit the parameter 
DocumentServerViewHTML to give it the value True instead of False. 

NOTE: Users of the Remote Client cannot view presentations in HTML format. 

To allow users to display presentations in HTML format

1 Start the Server Manager.

2 Enter the command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed in the 
Administration - Server Configuration screen. For more information, see Siebel System 
Administration Guide.

About Generating Presentations (End 
User)
Using template slides created by the presentation administrator, sales professionals can create, 
modify and print presentations for an opportunity, using the Opportunities screen > Presentations 
view.

Presentations automatically take details you have recorded about an account or opportunity and 
combine them with a predefined template to create a Microsoft PowerPoint presentation.

The administrator at your company creates presentation templates that include consistently 
formatted components, such as text, tables, and diagrams, that are designed to address specific 
issues. When you generate a presentation, you merge details about a specific account or opportunity 
in these predefined templates. 

After generating a presentation, you can modify it to meet your customer�s requirements by changing 
the order of slides and adding slides from the Presentation Library. If the presentation generated by 
a template is adequate, you can create and print it.

Scenario for Generating Presentations 
(End User)
This scenario provides an example of the business process performed by a sales representative 
creating presentations for prospective accounts. Your company may follow a different process 
according to its business requirements.
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A sales representative is asked by a prospective customer to deliver a presentation on service 
offerings. The sales representative has already recorded the opportunity and its related details in 
Siebel Sales, including the number one decision issue�price.

The sales representative navigates to the Opportunities screen�s Presentations view and creates a 
new presentation record. Because price is the most important decision issue, the presentation is 
based on a template that includes slides that address price issues. 

When the sales representative generates a draft of the presentation, the presentation is formatted 
according to standards established by the sales representative�s company, and includes the relevant 
slides. The sales representative makes some minor adjustments to the presentation, and saves it.

Process of Generating Presentations 
(End User)
To generate presentations, perform the following tasks:

■ �Creating a Presentation (End User)� on page 85

■ �Generating a Presentation Draft (End User)� on page 86

■ �Modifying Presentation Structure and Adding Content (End User)� on page 86

■ �Printing a Presentation (End User)� on page 91

■ �Locking a Presentation (End User)� on page 92

Creating a Presentation (End User)
Because presentations can include details about an account or an opportunity, presentations can be 
created from either the Accounts screen or the Opportunities screen.

This task is a step in �Process of Generating Presentations (End User)� on page 85.

To create a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, click Auto Presentation.

A presentation is automatically generated based on the default template. The new presentation 
record appears in the Presentations list.

NOTE: To generate a presentation using an alternate template, click New in the Presentation list and 
complete the necessary fields in the form.
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Generating a Presentation Draft (End 
User)
You can generate a presentation draft as a starting point for creating the presentation you deliver to 
a customer. The draft is a Microsoft PowerPoint presentation.

If you have Microsoft PowerPoint installed on your local computer, you can edit this presentation. If 
you do not have Microsoft PowerPoint installed, you can view the presentation, and you can add 
sections and change the order of sections, but you cannot edit slides.

If you are creating a presentation in a Siebel Web Client environment (network), follow Step 1 
through Step 4 in the following procedure.

If you are creating a presentation in a Mobile Web Client environment (remote) and have the Mobile 
Web Client installed locally on your computer, follow Step 1 through Step 3 in the following 
procedure.

This task is a step in �Process of Generating Presentations (End User)� on page 85.

To generate a presentation draft

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation, and then 
click Generate Draft.

In Queue appears in the Status field. 

A draft of the presentation is created if you are using Siebel Mobile Client (remote environment).

4 Click Update to generate a presentation from the server if you are working in a Siebel Web Client 
(network) environment.

The status of the presentation refreshes when you click Update. Status values include In 
Progress, Generating, Completed, and Failed.

Modifying Presentation Structure and 
Adding Content (End User)
After creating and viewing a draft of a presentation, end users may decide that they want to change 
the order of the sections or add new sections.

The following tasks describe how to view, modify, and add content to the presentation:

■ �Viewing the Structure of a Presentation� on page 87

■ �Adding Content to the Presentation� on page 87

■ �Changing the Order of Sections in a Presentation� on page 88

■ �Adding Components to a Presentation� on page 89
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■ �Modifying a Presentation Component� on page 91

These tasks are a step in �Process of Generating Presentations (End User)� on page 85.

Viewing the Structure of a Presentation
End users can view the structure of a presentation in the Presentation Table of Contents view, which 
allows viewing of the hierarchy of sections and components that make up the presentation. 

Sections represent the main points of a presentation, and each section can consist of subsections 
and components. Components are the slides used in each section. In some cases, sections can also 
be set up to generate slides.

To view the structure of a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field.

The Presentation Table of Contents appears showing the structure of the presentation.

3 In the Presentation Table of Contents explorer, click the plus sign (+) next to each section to 
expand sections and components.

Adding Content to the Presentation
If an administrator has created slides and included them in the Presentation Library, end users can 
customize the presentation by adding one or more of these slides using the Edit Layout command.

To add content to the presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation, and then 
click Edit Layout.

The Template Layout dialog box appears, displaying two columns:

■ The Content Library lists the components in the Presentation Library that can be included in 
the presentation.

■ The Table of Contents column lists the components in the Presentation Library that are 
selected for the presentation and the order in which they will be displayed.
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4 In the Content Library column, use the directional buttons to move selected sections from the 
Content Library column into the Table of Contents column. If you make a mistake, click Reset 
Layout to undo all changes to the Table of Contents column. When you are finished, click Save.

NOTE: If the Show Recommended Only check box is selected, only those components 
recommended by the administrator are displayed. If this box is empty, all available components 
are displayed. For more information, see �Allowing Users to Display Presentations in HTML Format� 
on page 84.

5 In the Presentations list, select the presentation, and then in the presentation record, drill down 
on the hyperlink in the Name field to view the new content.

Changing the Order of Sections in a Presentation
When end users add a section to a presentation, the section numbers are not automatically 
resequenced. If a section is inserted within the current sequence, end users must modify each 
sequence number. The sequence numbers in the Presentations list determine the order in which 
sections and components appear. 

There are two methods that can be used to resequence presentation sections and components:

■ Edit Layout.

■ Presentation Table of Contents.

To use Edit Layout

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, select the presentation in the Presentations list, and then click 
Edit Layout.

4 In the Template Layout dialog box, use the sequencing arrows to change the order of the 
sections, and then click Save.

To use Presentation Table of Contents

1 Navigate to Opportunities screen, and in the Opportunities list, select the opportunity associated 
with the presentation.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

3 In the Presentation Table of Contents explorer, click the plus sign (+) to expand each section.

4 In the Sections list, select a section, and change the number in the Sequence field.

To remove sections in a presentation

1 Navigate to the Opportunities screen > Opportunities List view.
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2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) to expand the sections.

5 In the Sections list, select the section and click Delete.

NOTE: You can also use the Edit Layout command to remove content from a presentation. For 
more information, see �To use Edit Layout� on page 88.

Adding Components to a Presentation
Components are the slides that make up presentations. Components can be added to sections from 
the Presentation Library, the Siebel Encyclopedia, or from another location, such as a local hard 
drive. More than one component can be added to a section.

The Presentation Library offers a hierarchical structure that administrators can use when designing 
literature components that can be associated with a presentation. Using the Presentation Library, end 
users can navigate to a section or subsection and select the component file associated with the 
section.

To add a component to a presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentations Table of Contents explorer, click the plus sign (+) next to the presentation 
you want to change. 

The Sections folder appears. 

5 Click the plus sign (+) next to the Sections folder.

Each section associated with the presentation appears in the Sections list. 

6 Click the plus sign (+) next to the section to which you want to add a component.

7 In the Sections list, click Library.

The Presentation Library view appears.

8 In the Presentation Library explorer, click the plus sign (+) for Presentation Library. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where the presentation is located. 

c Click the plus sign (+) next to the Components folder.

The list of components for that section appears. 
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9 In the Components list, select the component and then click Add Components.

The component file is added to the Components folder located in the section you selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click New.

6 In the Add Sales Tools dialog box, select each record you want to add and then click Add.

NOTE: Only PPT files can be added as components directly into a template section.

To add a component from another location

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the next to the section where you want to add a new file.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click New.

6 In the Add Sales Tools dialog box, click New.

7 In the Components list, enter a name and sequence for the file, and then click the select button 
in the File Name field to attach the file.

8 Attach the file using the Add Attachment dialog box.
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Modifying a Presentation Component
End users can modify a component file if they have Microsoft PowerPoint installed locally on their 
computer. End users must have the application that was used to create the component. 

To modify a presentation component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit. 

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, drill down on the hyperlink in the File Name field.

6 In the File Download dialog box, click Open to begin editing the file. Make any necessary edits 
and do one of the following:

a Click Save to save the file. If the Local check box is selected for this component, the file will be 
updated in the Siebel application.

b Click Save As to save the file to your local hard drive and then:

❏ In the Components list, select the component (saved locally), click Edit, and locate the 
modified component.

❏ Select the modified component, and then add it.

The old component is replaced with the new one.

Printing a Presentation (End User)
After generating a presentation, and the status is Completed, end users can print the presentation. 

This task is a step in �Process of Generating Presentations (End User)� on page 85.

To print a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation you want to print.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Draft Name field of the presentation you want to print.

The presentation appears in the application in which it was created. 
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3 From the application, print the presentation.

Locking a Presentation (End User)
Lock allows end users to secure the completed presentation, making the presentation read-only and 
unable to be edited. Only the presentation�s author, the author�s manager, that manager�s manager, 
and so on, can unlock or modify the presentation.

This task is a step in �Process of Generating Presentations (End User)� on page 85.

To lock the presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation.

4 In the presentation record, select the check box in the Locked field.

NOTE: If the Locked check box does not appear, click the menu button in the Presentations list, and 
then choose Columns Displayed. For more information about using Columns Displayed, see 
Fundamentals.

Sample Presentation Templates
Siebel Business Applications come with a sample database. The Administration - Document screen 
> Presentation Templates view includes several sample document templates.

These sample presentations can be used as a reference when defining your own presentation 
template. In this sample database you will find the following Siebel Presentations sample 
presentations: 

■ Corporate Presentation (Opportunity category)

■ Corporate Presentation - Account (Account category)
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6 Fulfillment Centers
This chapter is about setting up and using fulfillment centers to print and distribute documents 
generated through Siebel Correspondence or Siebel Proposals. It includes the following topics:

■ �About Fulfillment Centers� on page 93

■ �Process of Setting Up and Using Fulfillment Centers� on page 93

■ �Adding a Fulfillment Center Record� on page 94

■ �Giving the Fulfillment Center Access to Siebel Correspondence and Siebel Proposals� on page 94

■ �Sending Correspondence to a Fulfillment Center� on page 95

■ �Monitoring Fulfillment Requests� on page 95

■ �Recalling Submitted Correspondence� on page 96

About Fulfillment Centers
When your users have completed correspondence and want to send it to the recipient, either they 
can print out and mail the letter themselves, or they can direct their correspondence to a fulfillment 
center that prints and mails it for them. A fulfillment center might be a division of your company, 
such as your marketing department. 

You might want to use a fulfillment center for several reasons:

■ To allow your users produce correspondence in any location where they can access the Internet, 
even if they do not have a printer. 

■ To save your users time, since they do not have to print out and mail their correspondence.

■ To create consistency in your company�s outgoing correspondence.

■ To allow one location to fulfill all requests for collateral and literature materials included with 
correspondence as enclosures.

If you have set up fulfillment centers, the user can generate correspondence and then click Submit 
to submit the correspondence for fulfillment. When the user clicks Submit, the Status Field of the 
correspondence request changes to Submitted, and the request becomes read-only. You cannot 
make any further changes in it without using the Recall command.

Process of Setting Up and Using 
Fulfillment Centers
To set up a fulfillment center, perform the following tasks:

■ �Adding a Fulfillment Center Record� on page 94
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■ �Giving the Fulfillment Center Access to Siebel Correspondence and Siebel Proposals� on page 94

■ �Sending Correspondence to a Fulfillment Center� on page 95

■ �Monitoring Fulfillment Requests� on page 95

■ �Recalling Submitted Correspondence� on page 96

Adding a Fulfillment Center Record
You must create one or more fulfillment center records, so users can select a fulfillment center when 
they create a correspondence request.

This task is a step in �Process of Setting Up and Using Fulfillment Centers� on page 93.

To add a fulfillment center

1 Navigate to the Administration - Data screen > Fulfillment Centers view. 

2 In the Fulfillment Centers list, create a new record and complete the fields. Some fields are 
described in the following table. 

Giving the Fulfillment Center Access to 
Siebel Correspondence and Siebel 
Proposals
The fulfillment team at the fulfillment center must monitor pending fulfillment requests. Everything 
submitted by a requestor is visible to the fulfillment team in the Fulfillment screen.

Fulfillment center employees fulfill the request by viewing and printing the correspondence request 
and including the enclosures listed. The fulfillment center employees may either print the enclosure, 
or get an already-printed copy (if the enclosure is a glossy brochure, for instance). 

Field Comments

Name Enter the name of the fulfillment center.

Main Phone # Enter the telephone number of the fulfillment center.

Main Fax # Enter the fax number of the fulfillment center.

Fulfillment 
Team

Use the Fulfillment Team dialog box to select one or more employees at the 
fulfillment center. If necessary, click New to add employees to this dialog box. 
After you have selected the employees, click Close. 

These people will be able to view correspondence submitted to this fulfillment 
center. If there is no one on a fulfillment team, no one will be able to see 
correspondence submitted to this fulfillment center.

Description Enter a description of the fulfillment center.
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If you have licensed Siebel Workflow, you can create a workflow to send email to the fulfillment 
center automatically whenever there is a new request for it to fulfill.

This task is a step in �Process of Setting Up and Using Fulfillment Centers� on page 93.

To give the fulfillment center access to Siebel Correspondence

1 Set up fulfillment center employees as Siebel Correspondence users, in the same way that you 
set up your own employees or your channel partners as Siebel Correspondence users. For more 
information about setting up users of Siebel applications, see Security Guide for Siebel Business 
Applications. 

2 Give fulfillment center employees a responsibility that lets them see the Fulfillment screen. Use 
the responsibility in the seed data named Fulfillment Center Employee. For more information 
about responsibilities, see the chapter that discusses initial setup in Applications Administration 
Guide.

3 Tell fulfillment center employees what URL they should use to view correspondence through the 
Internet.

Sending Correspondence to a Fulfillment 
Center
When the fulfillment center has access to Siebel Correspondence, you can submit fulfillment requests 
from the Correspondence list. 

This task is a step in �Process of Setting Up and Using Fulfillment Centers� on page 93.

To send correspondence to a fulfillment center

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence that you want to submit to your fulfillment 
organization. 

3 Select the appropriate fulfillment center from the correspondence record�s Fulfillment Center 
drop-down list.

4 Click Submit.

The Document Status changes to In Queue.

Monitoring Fulfillment Requests
When you submit correspondence to a fulfillment center, the status of the correspondence is set to 
Submitted. When your correspondence request is fulfilled, the fulfillment center updates the status 
to Completed, which associates an activity with each recipient (contact). You can monitor the status 
to determine the date and time that your correspondence was sent and time your follow-up calls and 
sales visits accordingly.
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This task is a step in �Process of Setting Up and Using Fulfillment Centers� on page 93.

To monitor fulfillment requests

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence record, and then verify that Completed 
appears in the Status field.

Similarly, a fulfillment center manager monitors the status of pending requests by looking at the 
entry in the Status column of records in the Fulfillment screen.

Recalling Submitted Correspondence
You can recall correspondence records that you have submitted, as long as the correspondence 
records have not been fulfilled. You would recall correspondence to modify it and resubmit it for 
fulfillment.

This task is a step in �Process of Setting Up and Using Fulfillment Centers� on page 93.

To recall correspondence

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence you want to recall.

3 Click the menu button, and then click Recall.

The Status field value reverts from Submitted to In Progress. 
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7 Batch Printing
This chapter is about setting up and using batch printing for documents generated by the Document 
Server (Correspondence, Proposals, and Presentations). It includes the following topics:

■ �About Batch Printing� on page 97

■ �Setting Up Batch Printing for Administrators and Users� on page 98

■ �Batch Printing Instructions for Administrators� on page 98

■ �Configuring Printers for Server-Based Batch Printing� on page 99

■ �Batch Printing Instructions for End Users� on page 100

About Batch Printing
Batch printing simplifies the task of printing multiple correspondence items. The user first selects 
one or more correspondence items, and then selects the Print option from the menu button. The 
documents are then printed on the appropriate printer. 

Siebel applications support two types of batch printing, server-based and client based. Initially, the 
print menu item appearing in the Correspondence and Fulfillment screens is configured to perform 
client-based batch printing. However, the administrator can use Siebel Tools to reconfigure these 
menus to use server-based batch printing, either in addition to, or instead of, client-based batch 
printing.

Client-Based Batch Printing
When a user prints a document using client-based batch printing, the Siebel application launches 
Microsoft Word on the user�s client system. It then retrieves the document from the Siebel File 
System and prints it to the default printer configured for the user�s desktop session.

For this feature to work correctly, the end user must configure the browser to allow the Siebel 
application to launch Microsoft Word. This requires changing the security option called �Initialize and 
script ActiveX controls not marked safe� to either Enable or Prompt for the security zone containing 
the Siebel application URL. Typically, this is either the �Local intranet� zone or the �Trusted� zone. 
Users should verify that any other URL in this zone can be trusted with this security privilege.

Server-Based Batch Printing
When a user prints a document using server-based batch printing, a request is sent to the DocServer 
server component. This component then prints the document to the printer specified by the user in 
User Preferences. If the user has not specified a preference, the document is printed on the default 
printer configured on the Document Server machine by the system administrator.
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Setting Up Batch Printing for 
Administrators and Users
Table 9 lists procedures for setting up batch printing for both administrators and end users. 
Administrators need to set up server-based batch printing; end users need to set up both server-
based and client-based batch printing.

Batch Printing Instructions for 
Administrators
As an administrator, you need to set up the server-based batch printing function.

To add server Print menu items to the Correspondence and Fulfillment screens

1 Start Siebel Tools.

2 In the Object Explorer window, under Siebel Objects, select Applet.

3 In the Applets window on the right, enter �Correspondence List Applet� in the Name column and 
click Query.

4 In the Object Explorer, select Applet Method Menu Item.

5 In the Applet Method Menu Item window, enter �Server Printer� in the Menu Text column and 
click Query.

6 Highlight the record and clear the Inactive check box in the Inactive column.

7 In the Applet Method Menu Item window, enter Server Print Label in the Menu Text column and 
click Query.

8 Highlight the record, and clear the Inactive check box in the Inactive column.

9 In the Application menu, click Tools and select Compile Projects, and then in the Project Selection 
window, pick project Corresp (SSE). 

Table 9. Procedures for Setting Up Batch Printing

Setup Procedures for Administrators Setup Procedures for End Users

Add server Print menu items to the 
Correspondence and Fulfillment screens.

Verify system requirements for client-based 
batch printing.

Set up the printer configuration. Configure Internet Explorer to permit client-
based batch printing.

Add a printer connection to the Document 
Server machine.

Add a printer connection to the desktop for 
client-based batch printing.

Change the default printer (if necessary). Change the default printer (if necessary).

Specify a printer for server-based batch printing.
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10 Browse and select the appropriate siebel.srf file, and click Compile.

11 Repeat Step 3 to Step 10 for the Fulfillment screen, querying for Fulfillment List Applet in the 
Applet window.

12 Verify that Server Printer and Server Print Label menu items appear in the applet menus of the 
Correspondence and Fulfillment screens.

Configuring Printers for Server-Based 
Batch Printing
When a user invokes server-based batch printing on a correspondence document, a request is sent 
to the DocServer component. This request contains the values for the Default Printer and Printer 
Driver preferences the user has selected in the Siebel Correspondence User Preferences screen. After 
receiving the request, Document Server uses Microsoft Word to convert the document into a 
PostScript file. The style of PostScript generated is determined by the value for the Printer Driver 
user preference. This parameter specifies the name of a network printer. The PostScript file 
generated by Microsoft Word is suitable for this printer and all other printers of the same model. After 
the PostScript file is generated, Document Server sends the file to the printer specified in the Default 
Printer user preference.

As an administrator, you need to complete the following tasks to support server-based batch printing.

1 Identify the printer models within your enterprise that will be used for server-based batch 
printing.

2 For each model, select one network printer and add a printer connection to it on the Document 
Server machine.

3 Designate one configured printer as the default printer for the Document Server machine.

4 Provide the list of configured printers to end users, who will use this list to select a Printer Driver 
in User Preferences.

For example, an organization has five Xerox Model A printers, named xrx001 to xrx005, and five 
Canon Model B printers, named cnn001 to cnn005. A printer server named hqsrvr is used to route 
requests to all of the printers. The administrator decides to use xrx005 to represent the Xerox Model 
A printers and cnn005 to represent the Canon Model B printers, then adds printer connections on the 
Document Server machine for each. The xrx005 printer is chosen as the default printer. These 
connections are used by the DocServer component to generate PostScript files. Only one printer for 
each model is actually configured on the Document Server machine. After creating the printer 
connections, the administrator notifies the end users of the network names of the configured printers 
(in this case: \\hqsrvr\xrx005 and \\hqsrvr\cnn005).
Siebel Correspondence, Proposals, and Presentations Guide Version 7.8 99



Batch Printing ■  Batch Printing Instructions for End Users
Continuing the example, a user now wants to use the cnn003 printer for personal batch printing 
requests. To do this, the user navigates to the User Preferences screen > Correspondence View and 
enters \\hqsrvr\cnn003 in the Default Printer field and \\hqsrvr\cnn005 in the Printer Driver field. 
All subsequent batch printing requests the user submits are sent to the cnn003 printer. 

NOTE: If a user does not specify a default printer in the User Preferences screen > Correspondence 
view, then batch printing requests (submitted by that user) are sent to the Document Server�s 
default printer. In this case, printing is directly through Microsoft Word; no intermediate PostScript 
file is created.

To add a printer connection to the Document Server machine

1 Login to the Document Server machine using the same User ID used by the Windows Service 
running the Siebel Server.

2 Select Start > Settings > Printers.

3 Double-click the Add Printer icon.

4 On the Welcome screen, click Next.

5 On the Local or Network Printer screen, select Network Printer and click Next.

6 On the Locate Your Printer screen, select Network Printer and click Next.

7 On the Default Printer screen, select either Yes or No and click Next.

8 Click Finish.

To change the default printer

1 Login to the Document Server machine using the same User ID used by the Windows Service 
running the Siebel Server.

2 Navigate to Start > Settings > Printers.

3 In the printer list, right-click the desired printer and choose Set as Default.

Batch Printing Instructions for End 
Users
To batch print, end users select correspondence items in the Correspondence screen list, click the 
menu button, and then click Print. The Print menu item is only active if the selected correspondence 
record has a value of Completed in the Document Status field.

The Print menu item in the Correspondence and Fulfillment screens is configured for client-based 
printing. However, administrators can configure server-based printing in addition to (or instead of) 
client-based printing.

Check with the system administrator to determine which print method is available.
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Preparing for Client-Based Batch Printing 
To prepare for client-based batch printing, complete the following tasks:

■ �To configure Internet Explorer to allow client-based batch printing� on page 101

■ �To add a printer connection to your desktop� on page 101

■ �To change the default printer� on page 102

■ �To print documents using client-based printing� on page 102

When you use client-based batch printing, the Siebel application launches Microsoft Word on your 
client system. The application retrieves the document from the Siebel File System and prints it to 
the default printer configured for your desktop session. Before using client-based batch printing, 
verify that the following prerequisites have been completed:

■ Install Microsoft Word on the client system.

■ Configure Internet Explorer to start Microsoft Word.

■ Configure the default printer for your desktop system.

NOTE: The options in the following procedures may vary depending on which version of Microsoft 
Office you are running.

To configure Internet Explorer to allow client-based batch printing

1 Start Internet Explorer and log in to the Siebel Sales application.

2 In Internet Explorer, select Tools > Internet Options.

3 Select the Security tab, and click Custom Level.

The security zone used by Siebel is highlighted (either Local intranet, or Trusted). Verify that any 
other URL in this zone can be trusted with extra security privileges.

4 In the Security Settings dialog box, locate the following option: 

Initialize and script ActiveX controls not marked safe

5 Change the option setting to either Enable or Prompt, and click OK.

6 Click Yes to answer the question, Are you sure you want to change the security for this zone?

7 In the Internet Options dialog box, click OK.

To add a printer connection to your desktop

1 Select Start > Settings > Printers.

2 Double-click the Add Printer icon.

3 Click Next in the Welcome screen.

4 In the Local or Network Printer screen, select network printer, and then click Next.

5 In the Locate Your Printer screen, select Type the Printer Name.

6 Enter the network name of the printer, or click Browse and select the printer, and then click Next.
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7 In the Default Printer screen, choose either Yes or No, and then click Next.

8 In the Completing the Add Printer Wizard screen, click Finish.

To change the default printer

1 Select Start > Settings > Printers.

The current default printer is marked with a check mark.

2 Select a new default printer by right-clicking the desired printer and choosing Set as Default.

To print documents using client-based printing

1 Close files that are open in Microsoft Word.

2 Navigate to either the Correspondence screen or Fulfillment screen.

3 In the Correspondence list, select one or more records.

Each selected correspondence record must have a Document Status of Completed.

4 In the Correspondence list, click the menu button, and then click Print.

The selected documents are printed to the default printer.

Preparing for Server-Based Batch Printing
To prepare for server-based batch printing, complete the following tasks:

■ �To specify a printer for server-based batch printing� on page 102

■ �To print documents using server-based printing� on page 103

Server-based batch printing sends a printing request to the Siebel Document Server. The document 
is then sent to the printer specified in User Preferences. If you do not specify a printer, the document 
is printed on the default printer configured by the system administrator.

To specify a printer for server-based batch printing

1 Navigate to the User Preferences screen > Correspondence view.

2 In the Default Printer field, enter the network name of the printer used for Correspondence. 

The network name should contain both the printer server name and the printer name as shown 
in the following example.

\\printer_server_name\printer_name

3 In the Printer Driver field, enter the name of the printer driver used to generate an intermediate 
file during the printing process, and then click Save.

The system administrator should provide you with a list of printer drivers and their associated 
printer types. Select the Printer Driver associated with the printer you previously specified in 
Step 2.
Siebel Correspondence, Proposals, and Presentations Guide Version 7.8102 



Batch Printing ■  Batch Printing Instructions for End Users
To print documents using server-based printing

1 Navigate to either the Correspondence screen or Fulfillment screen.

2 Select one or more records in the Correspondence list. 

Selected correspondence must have a Document Status of Completed.

3 In the Correspondence list, click the menu button and then click Print.

The selected documents are printed to the default printer specified in User Preferences.
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